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About Arrisca Version 4 : FlexProfessional™ 
 
 
Thank you for purchasing FlexPro™ from Pre-emptive Analytics or one of our 
resellers. We value your business as a new FlexPro™ customer. 
 
FlexPro ™ can be used for quality assurance and control (verification and 
validation) and to deliver an improved understanding of the mechanics of the 
data. 
FlexPro ™ is not an add-in but a discreet piece of software that dynamically 
interacts with Microsoft Excel® to enhance the capability of the user. 
 
FlexPro ™ is especially useful for getting to grips with spreadsheets which have 
been built by others. It will quickly and transparently enable the user to 
understand the mechanical data relationships in the workbook and identify the 
key input elements – known as Drivers - that affect the outcomes of the model.  
 
Software Structure. 
 
We hope you find FlexPro ™ useful and easy to operate. 
We are eager to hear your feedback – either positive or critical - and ideas. 
Contact information is provided in the Support section of this document. 
We wish you an enjoyable and productive experience. 
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 Indicates there is important note 
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1 Getting Started 

 

1.1 Installation Guide and System Requirements 

 
Arrisca Version Ver 4.0: FlexProfessional™ is provided on an installation CD. 
If you have access to network installation, please contact your network 
administrator for installation instructions. 
 
System requirements 
Operating System: Microsoft Windows 7. 
Microsoft Excel®: Office 2010 and 2013. 
 
 
FlexProfessional™ requires about 100MB of free hard disk space. 
There are no other specific hardware requirements. 
 
Installation 
Insert the installation CD in your CD drive. 
Run file [CD]:\Setup.exe 
Follow the on screen instructions. 
The Licence key code can be found in licence agreement supplied with the CD or 
via email.   
Microsoft .Net© may need be installed to ensure full functionally  
 
You must restart your PC after installation to complete the process. 
 
The installer places an application icon onto the desktop which you will see after 
installation. This icon is used to start the application and load the workbook. 
 

 

 The software includes “factory set” terminology that relates to a ISO 
15-288 organisation  such as the MoD, it also has pre-set ‘risk category’s’ for 
risk identification/classification, you are advised to check your organisation 
procedures and policy’s to ensure that the terminology is appropriate. 
 
All of the pre-settings can be ‘User’ adjusted to meet your requirements see 
section 9  
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 Enabling the extended run-macro function within Excel. 
To enable the run-macro function during FlexProfessional™ sensitivity analysis 
you must alter an Excel security related setting in the Excel application as 
follows: 
 
 
MS Office 10 
1. Open Excel 
2. From the File tab select Options>Developer (this will open a new Excel Tab) 
3. From The Developer Tab select Marco Security> “Trust access to the VBA 

Project  object Model” 
4. Click OK 
5. From file tab select Options>Trust Centre. 
6. From Trust Centre options select Macro Settings> “Enable all macros” 
7. Press OK and close Excel 
 
 
The setting will be effective next time Excel is opened. 
You will be able to control Excel macros during FlexPro sensitivity analysis. 
Refer to the ‘Select Macros’ section of this manual for details. 
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1.2 Launching the application 

The application is launched from an icon on the desktop. 
 

1. Double Click on the application icon on the desktop. 
 

  
 
 

2. The ”Select Application to Flex” start screen will be displayed.  
 

 
 

3. Select Excel option under MS Office. This will display the “Open Analyser” box 

 
 
 
4.  Select the option you require: 

 Open new XL workbook – Browse for a workbook to perform an analysis 

 Open Arrisca RAF file – Load a previous analysis as a complete package 

 Open last assessment – Return to the last activity-state of the application 

 Recover post-error – for use in case of an undesired application failure 
 

 

 

 
 
 



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 10 

2 Application Launch and Navigation Excel option 

 

2.1.1 Open new XL workbook 

1. Click once on the Open new XL workbook button. 
The Select Spreadsheet dialog box will be displayed: 
 

 
 

2. Select the workbook you wish to analyse and click Open.  
The workbook will automatically open and the FlexProfessional Initialisation cell-
selector box will be displayed above the attached workbook, as below: 
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3. Select the worksheet and cell you wish to analyse the inputs and risks against. 
The cell reference will appear in the Initialisation box.  
Hint: This must be a calculation or formula. It’s usually the final value.  
This cell is known as the Key Output Cell (KOC) in the FlexPro application. 
 

4. Click OK and the application will load and display the Driver Analysis Tab. 
 

You are now ready to perform Sensitivity, Uncertainty and Risk & 
Opportunity analysis to UK Treasury Green Book compliant standards. 
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2.2 Application Navigation 

The FlexPro application is controlled using an intuitive combination of View 
Panes, Menus, Function Tabs, Feature Bars and Control Buttons.  
 
 
 
 
 
 
 
 
 
 

 
 
 
  
 
  

Main Menu contains high level 
commands and access to 
parameters and settings that 
apply globally to the 
application. 

Function Tabs provide easy 
instant access to the major 
functional areas of the 
application. Function Tabs 
feature context-sensitive 
menus and Feature Bars. 

Feature Bars contain 
Function-specific commands 
that allow the user to interact 
with the application. All 
Feature Bar controls, text, 
commands and layouts are 
user-configurable. 

Command Buttons are simple 
controls that execute specific 
functions or features. 

View Panels are dynamic 
panes that contain lists and 
control windows. Both the 
main application window and 
all panels are resizable and 
have a ‘size-memory’. 
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3 Start Control function tab 

 
The Start Analysis Function Tab displays and manages controls related to the 
driver analysis itself. It can be accessed at any time from its Function Tab. 
 

 
 
 

3.1 Feature Bar - Analysis Control 

The Feature Bar contains function-specific controls and information pertaining to 
the attached workbook and Driver Analysis Control: 
 

 
 

3.1.1 Select worksheets command   

This command allows you to change what is included in the main panel selection: 

 All Worksheets 

 Key worksheet only (only the worksheet that contains the Key 
Output Cell) 

 > zero inputs (all worksheets that have at least one viable input 
cell) 
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3.1.2  Options command      

 
 
This command allows you to select Driver Analysis utility options: 

 
 

 Change Analysis Multipliers 

Allows you to modify the upper and lower multiplier limits that are 
used during the sensitivity analysis itself. This will display a pop-up 
window that will allow you to enter new flex values for use in 
analysis The default values are +10% of the input cell’s value. 

 
 

 The actual effect of each input, or Driver, is calculated 
from the Cumulative Effect of both the increase and reduction in 
the value of the input during analysis. 

  Show spreadsheet during analysis 

Select this option to display the workbook during the Driver Analysis 
so you can see the data being flexed.  

 The workbook is normally hidden during the Driver Analysis 
– visibility of the workbook slows the analysis down considerably. 
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 Change Target Values command- 

 
Provides the facility to present additional bars on the S-curve 
reports to represent the desired outcome, which may be different 
from the deterministic or other confidence-related values To ensure 
that the graphic outputs reflect requirements, the target Value 
(Absolute), Base value(Divisor format) and currency can be changed 
via popup menus. 
 

 

 New Targets are displayed in the Spreadsheet Information 
Panel; it may be necessary to drag panel open to see results. 
 

 Password protection  

 FlexPro cannot flex protected or read-only worksheets or areas. 
You must either deselect the worksheet from the list of included 
worksheets or unprotect it. If you have selected a protected or 
read-only worksheet for analysis, you will get the following pop-up 
message on clicking the Start button and you must either deselect 
or unprotect the worksheet to continue with analysis: 

 
 

 

3.1.3 Highlight Cells Types          

This provides the option the highlight the Excel worksheet with either the 
constants or formulas thereby aiding the audit and verification of the 
Spreadsheet. 
  



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 16 

 

3.1.4 Replace external workbook(s) links  

External Link management – allows you to replace links to external workbooks 
with the value of the link. The linked cells are highlighted and a comment is 
added to the cell with its original linked location for auditability. If they are not 
incorporated they will not be included in the sensitivity analysis. Look for Red 
warning in spreadsheet information panel and use Replace ‘n’ external 
workbook links tab to collect data. 
 

 
 
 
 

3.1.5 Workbook Links    

All reference to any workbook link can displayed in the primary excel sheet or 
can copied the MS clipboard from where they can be incorporated in any 
documentation.  
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3.1.6 Name Ranges 

 
 
 
 
This allows you to select what rows containing ‘named ranges’ are displayed in 
the worksheet display panel. 

: Ensure that the ‘Name Ranges’ option in the display panel is selected 
before using the ‘Name ranges’ features. 

3.1.7 Licensing and Upgrades    

This will link to our web site that explains the capability of each version of our 
software and how to upgrade the product that will meet your needs. 
 

3.1.8 Spreadsheet Information Panel    

  
This panel displays summary information relating to the workbook that FlexPro is 
currently attached to and will analyse. This includes the directory location and 
the file name of the workbook as non-editable fields. 
Also displays important information regarding any linked workbook. 

 
The location, value and name (should it have one) of the Key Output Cell are 
also displayed. This is a very important field as the inputs will be measured by 
their effect on this cell during analysis. The Change button allows you to modify 
the selected cell. 
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: The Key Output Cell must be a formula or calculation, not an input 
constant. Any changes via the “Change” button will not take effect until a 
analyse is run 
 

3.1.9 Start Driver Analysis  

    
This prominent button starts the Driver Analysis function. 
To start the Driver analysis: 

1. Click once on the green Start Driver Analysis button. The Excel workbook is 
hidden from view and a progress indicator is displayed to inform the user of 
analysis status. 

2. During analysis the button changes to a red Stop button. 
3. When the analysis is complete the Sensitivity Function Tab is displayed. 

 

 Warning- If the workbook uses formula linked to “Dates” in a date 
format, the sensitivity output will be bias towards those dates, change date 
cells to a formula format to overcome any issues.    

Warning- spreadsheets should fully verified to ensure that pure inputs 
(constants) have not been entered as a formula cell (eg = 123 ) as the Arrisca 
tool will not include them in a sensitivity analysis.  
 

The sensitivity analysis will produce results based on the deterministic 
inputs and all the elements that make up a risk impact e.g. probability, Min. 
ML & Max values 
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Start- worksheet view panel 
Depending on the Display options selected (Section 3.1.1), the main view panel 
allows you to select or deselect the worksheets, macros or functions you do and 
do not want to include or run in the Driver Sensitivity analysis. 
 

 
 
Each worksheet in the workbook is summarised by a row in the panel.  
Information about the number of inputs and formulae is provided alongside each 
worksheet name along with an indication of its read-only or protected status.  
At the bottom of the window the sum total of all selected inputs is displayed. 
By default, all worksheets are selected.  
Use the checkboxes to select or deselect specific worksheet types for analysis or 
use the Include command on the Feature Bar as described in Section 3.1.2. 
 
The cell summary panel at the base of the Driver Analysis Function Tab shows the 
total number of Inputs and Formulae that are contained in the selection. 
 
 

 You cannot deselect the worksheet that contains the Key Output Cell. 
 

 Deselect sheets you know to be reports, graphs, outputs or tables that 
don’t contribute to the final value. The selection window displays guide 
information regarding the number of potential inputs and formulae in each 
sheet. In general, the fewer sheets that are selected, the faster the analysis 
will be completed. 
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3.2 Subroutine/Functions 

The Subroutines/functions panel allows you to view any additional coded 
functions that exist in the workbook. You cannot run these from FlexPro because 
of their use of programming arguments that may need to be passed to or from 
other code areas and makes them unreliable to run as macros, so we list them 
instead. 
 
If you want to use a Subroutines/functions, remove or replace its coded 
arguments in Visual Basic, save it and it will appear as a macro in the Macro list 
on reload. 
 

3.3 Start- Macro view panel 

The Macros panel allows you to select or deselect any macros that exist in the 
workbook that you may want to run during the execution of sensitivity analysis. 
 

 
 
Each available macro in the workbook is summarised by a line in the panel.  
 
By default, no macros are selected. 
Use the checkboxes to select or deselect each macro for analysis. 
You may define the order in which the macros are run by manually selecting and 
editing the Execute Order field. Select the Execute Order field for the desired 
macro, type the new order number and press the Enter key on your keyboard. 
 

 You can sort by Run, Execute Order or Name columns by clicking on the 
blue field column titles. 

All macros need to be reviewed to ensure there are no embedded factors 
that may affect the outcome of the model. 
 

 Running macros can significantly increase the time taken to run 
analysis. 
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3.4 Name Ranges 

 
By default all named ranges within the spreadsheet are displayed invalid ranges 
are automatically excluded and highlighted in red. To select what is displayed 
use the ‘name ranges’ feature tab see 3.1.6  
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4 Sensitivity function tab 

 
The Sensitivity panel displays the results of the Driver Analysis and allows you to 
manipulate and monitor the inputs that were identified as Drivers. This is the 
primary interactive screen for Driver display, management and flexing. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Many of the functions descripted in this section of the manual can be 
accessed by a “right” click on the mouse see 4.2.2.  

View Panels are dynamic panes that contain lists and 
control windows. Both the main application window and 
all panels are resizable and have a ‘size-memory’. 

 Input Control Panel enables 
selected drivers to be flexed 

Watch Panel by default 
the target cell selected 
for the analyse is 
displayed 

 Driver Details Panels 
enables comments be added 
and classify the item with 
corporate terms 
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4.1 Feature Bar - Sensitivity  

The Feature Bar contains function-specific controls and information pertaining to 
the Sensitivity results of the Driver Analysis: 
 

4.1.1  View command    

 
This command allows you to change which Drivers are displayed in the main 
Sensitivity Drivers panel: 
Options: 
 

 Top ‘N’ inputs 

 Above a Percentage 

 Working inputs   

 Non- working inputs 

 With Positive effect 

 With Negative effect 

 Above a certain value 

 All 

 Hidden 

 Worksheets 
o Filter 
o Remove Filter 

 Driver category 
o Filter 
o Remove Filter 
o TornadoRelative-100% of the width represents the biggest 

driver value 
o Absolute- the bars occupy n % of the column width by % effect 

 Tornado  
o Relative 
o Absolute 

: The ability to display elements in their order of importance is key to 
the Assurance and Due Diligence function within an Organisation. 

: Listing “Non-working inputs” and “hidden” elements provide support to 
the workbook Verification process of an Organisation. 
 
 

4.1.2 Re-Analyse workbook command   

This command will re-run analytical analysis and transfer the result to workbook.    
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4.1.3 Export Command 

 
This allows the sensitivity analyse to be exported to the desired MS tool  

4.1.4 Options command 

 
As default the watch panel contains the “target cell”, additional cells can be 
added via the ‘Add Output cell(s) to watch window ‘command.  
The Hide command enable single or multiple driver rows to be removed from the 
viewing pane; their effect on the sensitivity analyse is not affected.  
To bring hidden rows into view select the View tab, Hidden option, chose the 
rows then either select Unhide from the Options tab or right click the mouse and 
select “unhide” from the “Driver Actions” option 
The Apply command allows you to decide where comments and or Names that 
are entered in the Drivers Details Panel are displayed after they are Saved via 
the Driver Details panel  
Options:   

 All  Change every row 

 Listed  Change listed rows 

 Select  Change selected rows 
 

    

4.1.5 3 PE (Point Estimating) 

 Generate 3 Point Estimate 

This command will allow you adjust the driver set by generating 3 point 
estimates, results can be viewed in the Uncertainty section. 
Method: select rows to adjusted, select 3PE Generate 3 Point Estimate, chose 
distribution shape and required values for Min, Most Likey & Max, press 
Generate button. 
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 Show Driver in Uncertainty Tab command 

This command allows you transfer selected drivers to the Uncertainty Register 
such that they may have Uncertainty Assessments made on them. 
 
To transfer cells to the Uncertainty Register: 
1. Select the Drivers you want to transfer to the Uncertainty Register 
2. Click on the 3 PE tab > select Show Drivers in Uncertainty Tab command. 
3. A confirmation message is displayed. Click OK to finish operation. 

The selected cells are displayed in the Uncertainty Drivers List on the 
Uncertainty Function Tab. Their shapes are highlighted in red to indicate no 
assessment has yet been made. 
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 Generating Uncertainty Inputs 

 

 
 
Uncertainty may be added by recording the manipulation of the Sensitivity 
Drivers on the Sensitivity 3 PE Function Tab.  
To add Uncertainty from manipulation of the Sensitivity Drivers: 
 
1. Select the Drivers (cells displayed) to be flexed and added to the Uncertainty 

List 
2. Set Likely values THIS MUST BE DONE FIRST 

i. Use either the Input Control Slider or the + or - Flex Buttons to 
manipulate the selected drivers to a desired state which 
represents a set of Likely Uncertainty values 

ii. Select 3PE > ALL or Selected> Apply Flex values to 
Uncertainty select As 3PE Likely 

iii. A progress indicator appears and a confirmation message is 
displayed once the task is finished. Click OK to complete.  

iv. The Driver cells have been added to the Uncertainty Drivers List 
on the Uncertainty Function Tab with a Constant shape of the 
value set by the flex manipulation 

3.  Set Minimum values: 
i. Use either the Input Control Slider or the + or - Flex Buttons to 

manipulate the selected drivers to a desired state which 
represents a set of Minimum Uncertainty values 

ii. Select 3PE > ALL or Selected> Apply Flex values to 
Uncertainty  > select As 3PE Minimum 

iii. A progress indicator appears and a confirmation message is 
displayed once the task is finished. Click OK to complete.  

iv. The Minimum values have been added to the parameters on the 
Uncertainty Drivers List on the Uncertainty Function Tab. The 
shape is now indeterminate and is highlighted in red. 

4. Set Maximum values: 
i. Use either the Input Flex Control Slider or the + or - Flex 

Buttons to manipulate the selected drivers to a desired state 
which represents a set of Maximum Uncertainty values 

ii. Select 3PE > ALL or Selected>  Apply Flex values to 
Uncertainty > select As 3PE Maximum 

iii. A progress indicator appears and a confirmation message is 
displayed once the task is finished. Click OK to complete.  

iv. The Maximum values have been added to the parameters on the 
Uncertainty Drivers List on the Uncertainty Function Tab. The 
shape is now Triangular and the assessment is complete. 
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4.1.6 Risk 

This command enables either the inclusion of pre-defined risks or the ability to 
create new risks, both risk details and metadata can be captured, the metadata 
elements can be user defined allowing user selection from a dropdown menu. 
Once the risk detail is saved via the save and close button, you will be prompted 
to select the drivers that are affected by the risk.  
 

 
 
Add to selected drivers method: 

1. Select Driver(s) using crtl for multiple choice select Risk>Add to selected 
drivers from the sensitivity function tab. 

2. A popup “Select Risk” menu will appear either selected a listed risk or 
press New. 

3. If New was selected a Popup form appears, this is in two parts: 
a. Definition – You are required to name and describe the risk and 

state the Risk Code and Risk manager. If Blanket Probability is 
chosen you must input a probability factor.  

b. Meta Data - will require you to fill the relative metadata via 
dropdown menus. These dropdown menus can be update by the 
user to reflect your Organisations policy see 9.1.2.8 for details. 

4. Press Save and Close a new popup form will appear that requires you to 
Define selected Driver Impacts  

5. The affected driver is displayed in “target” area of the popup form. 
6. Set Probability: 

a. Select either of the Qualitative or Quantitative options in 
probability sub panel.  

i. Qualitative: Select the desired Probability Level from the 
drop-down list that appears to the right of the option; 

ii. Quantitative: Type in the desired Probability value ( an 
integer between 0 and 100) in the field that appears to the 
right of the option. 
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iii.  
7. Set Impact(the impact of the risk not to be confused with the uncertainty 

estimate): 
a. Select either of the Qualitative or Quantitative options in the 

Assessment sun panel.  
i. Qualitative:  

1. Select either Relative or Absolute levels; 
2. the desired Impact Level from the drop-down list that 

appears to the right of the option; 
ii. Quantitative: 

1.  Select the desired Shape from the drop-down list that 
appears to the right of the option; 

iii. Type in the desired Impact Values (min, likely, max, etc) in 
the fields that appear underneath the shape drop-down. 

8. Click Save a popup message will appear to give progress press OK. 
 
Add to All 

1. Select Risk>Add to ALL from the sensitivity function tab. 
2. A popup “Select Risk” menu will appear either selected a listed risk or 

press New. 
3. If New was selected a Popup form appears, this is in two parts: 

a. Definition – You are required to name and describe the risk and 
state the Risk Code and Risk manager. If Blanket Probability is 
chosen you must input a probability factor.  

b. Meta Data - will require you to fill the relative metadata via 
dropdown menus. These dropdown menus can be update by the 
user to reflect your Organisations policy see 9.1.2.8 for details. 

4. Press Save and Close a new popup form will appear that requires you to 
Define selected Driver Impacts  

5. The affected driver is displayed as blank as all drivers are affected in the 
“target” area of the popup form. 

6. Set Probability: 
a. Select either of the Qualitative or Quantitative options in 

probability sub panel.  
i. Qualitative: Select the desired Probability Level from the 

drop-down list that appears to the right of the option; 
ii. Quantitative: Type in the desired Probability value ( an 

integer between 0 and 100) in the field that appears to the 
right of the option. 

7. Set Impact (the impact of the risk not to be confused with the 
uncertainty estimate): 

a. Select either of the Qualitative or Quantitative options in the 
Assessment sun panel.  

i. Qualitative:  
1. Select either Relative or Absolute levels, see note 

below; 
2. the desired Impact Level from the drop-down list that 

appears to the right of the option; 
ii. Quantitative: 

1.  Select the desired Shape from the drop-down list that 
appears to the right of the option; 
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iii. Type in the desired Impact Values (min, likely, max, etc) in 
the fields that appear underneath the shape drop-down. 

8. Click Save a popup message will appear to give progress press OK. 
 

 
 Relative will produce values for min. most likely and max (3PE) based on 

the deterministic value used in the model. 

 Absolute option will add the deterministic value to the pre-determined 3 
PE defined by “User”. This option is best suited to “Design to cost” 
modelling when detailed risk impact information is limited. 

 
 

Blanket Probability will take presentence over individual risk settings if 
two or more risks have an impact on a selected cell 
 
 
. 
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4.1.7 Highlight Driver Cells command   

The application provides functionality for marking the input drivers displayed on 
the Sensitivity Drivers panel. It does this by using Excel to highlight cells.

 
 

 To highlight the input driver cells currently displayed in the 
Sensitivity Drivers panel:  

4.1.7.1.1 Heatmap 

1. Select “by heatmap” 
2. Select from popup menu the combination required for the display 
3. Press Highlight 
4. Press Undo to remove any highlighting  
5. The save option will remember your chosen combination of colours and ‘n’ 

inputs. 
6. Close option shuts heatmap. 

 

 
 

4.1.7.1.2 Current Selection 

1. Select for display the Driver cells you want to highlight 
2. Click once on the Highlight Driver Cells command. 

The Highlight Drivers dialogue box will be displayed; 
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3. Select the required highlight colour from the drop down colour selector 
and then click the Highlight button once. A message will confirm the 
action. Click Undo to remove the last highlight action. 

 

: To create a Driver ‘heatmap’ based on significance, define and display 
sets of Drivers using the Drivers to Display control and different highlighting 
colours. 

  When using the heatmap function for spreadsheet verification i.e. 
to check for “non-working” inputs on sub totals within the spreadsheet it is 
necessary to set the display options so that only “non-working” inputs will 
be highlighted. 

It should be noted that where an input cell value is used in many 
formulas it will not show up as non-working cell if missed from say a sub 
total elsewhere in the spreadsheet. 

Input cells that have a value of zero will be classified as Non-Working 
 
 

4.1.8 Reset all drivers command   

This command allows you reset any changes that have been made to Driver cells. 
 
To reset Driver cells to their original (deterministic Excel) values: 
1. Click once on the Reset all drivers command. 
2. All Drivers will be returned to their original values. 
 

 Comments and Names cannot be reset 
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4.2 Sensitivity Drivers panel 

The Drivers Panel displays the results of the analysis in tabular format. 
 

 

4.2.1 Columns 

The columns are used to summarise the analysis results and subsequent flexing. 
To sort the data by a column in descending order click on the column title bar 
text. A second click on the column title bar text will sort in ascending order. 
 

4.2.2 Analysis Results columns 

These columns are used to display deterministic (original) workbook input data 
and the results of the sensitivity analysis once completed. 
 

A. No. 
Displays the unique line number of the driver list.  

 
B. Rank 

Displays the Driver ranking sorted by decreasing effect. The most 
influential Driver is ranked number 1. All drivers below this have less 
effect for a given amount of flex than this driver. 

 
C. Name of input cell 

If the cell has a name in Excel it will be displayed here. If the cell does 
not have a name you can type a name into this field and then apply the 
name to the Excel workbook by clicking the Apply Names Feature Bar 
command. 
Tip: This is a quick way of naming the significant Driver input cells. 
 

D. Worksheet 
Displays the Excel workbook location of the Driver input cell.  
 

E. Cell 
Displays the Excel worksheet location of the Driver input cell.  
 

F. Input cell value 
Displays the input cell value from the Excel workbook without format 
 

G. Format 
Displays the format of the Driver input cell, includes custom formats. 
 

A 

B 

C 

D 

E 

F 

G 

H 

I L 

K 

J M 

N 

O 
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H. Effect @ ‘n’% 
Displays the amount the Key Output Cell is affected by the sensitivity 
analysis at the settings defined in the Analysis Multipliers control. The 
column heading displays the cumulative sensitivity value used in analysis.  

 The length of the coloured slider in this column indicates the 
impact on key output cell 
 

 : If the analysis was executed at the default of +10% then the 
column heading will read ‘Effect @ 10%’. 
 

I. Effect at 90 and 110% / Tornado Bars 
Displays the effect of the cell at the given flex value as a percentage of 
the Key Output Cell value. i.e. If the KOC value is 1000 and the ‘Sensitivity 
@ 10%’ is 100 (from the previous column) then the Effect% will be 10. 
The background displays a graphical representation of the effect of the 
Drivers list on the Key Output Cell. The tornado bar is colourised to 
indicate polarity of effect: 

a. Red = Direct: KOC value increases as Driver cell value increases. 
b. Green = Inverse: KOC value decreases as Driver cell value increases. 

The scale view of the Tornado bars can be changed from Relative to Absolute 
by using the Tornado command on the Feature Bar. 
 

4.2.3 Flex Control columns 

These columns are used to dynamically flex and manipulate the workbook input 
data and display the flexed data values. During manipulation the Excel workbook 
is manipulated and is updated with the flexed input values so you can see the 
effects of the manipulation on the workbook. These changes are not 
automatically saved but this can be done by using the Save as menu item in 
Excel 
 

J. – (minus character) increment control 
This control is used to reduce the Driver input value by 1% increments 
Click on the minus character to reduce the input cell value by 1% per 
click. The control is colourised to indicate the polarity of the resulting 
effect on the Key Output Cell as follows: 

a. Red = KOC value increased as a result of the input cell decrease 
(denoting an inverse relationship). 

b. Green = The KOC value decreased as a result of the input cell 
decrease (denoting a direct relationship). 
 

K. Delta 
Displays the percentage delta value in percentage terms of the Driver 
input cell if manipulated. If the cell has not been manipulated the field 
displays zero value. 
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L. +  (plus character) increment control 
This control is used to increase the Driver input value by 1% increments 
Click on the minus character to increase the input cell value by 1% per 
click. The control is colourised to indicate the polarity of the resulting 
effect on the Key Output Cell as follows: 

a. Red = KOC value decreased as a result of the input cell increase 
(denoting an inverse relationship). 

b. Green = The KOC value increased as a result of the input cell 
increase (denoting a direct relationship). 
 

M. Flexed value 
Displays the new (flexed) value of the Driver input cell if manipulated. If 
the cell has not been manipulated the field displays the original cell 
value. 
 

: If you want to set the Driver input value to a specific value 
rather than use the plus / minus incremental controls you can select this 
field and type in the desired value. Press the Enter key on your keyboard 
to update the value. 

4.2.4 Information Columns 
 

N. Category  
Displays the assigned identification; this should align with your 

organisations process or policy on identifying risk and uncertainty. 
    

O. Comments 
   Displays the user input comments 
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4.2.5 Sensitivity Driver panel contextual menu (right-click)  

Select the row from sensitivity display panel, there are a number of options 
available by making a right click menu, as shown below:   

 

 Goto this cell in workbook 

 Goto this cell in workbook – selects and focuses target cell 
 

: This is a quick way of finding the Driver inputs in the Excel 
workbook. 

 

 Driver Actions sub menu 

The following options are available: 
 
 

 Reset – returns this cell to its original Excel values comments and names 
added are not affected. 

 Exclude cell from sensitivities – inserts an ‘=’ sign as a prefix to cell 

 Hide – hides cell from Drivers list 

 Unhide restores hidden rows 
 

 Apply Selected menu 

This command transfers the current cell value to the Uncertainty assessment, 
full flex instruction are detailed in 4.1.7.; options are available: 
 

 Minimum – applies New Value to Uncertainty minimum value 

 Likely – applies New Value to Uncertainty likely value 

 Maximum – applies New Value to Uncertainty maximum value 
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 Highlight menu 

This command highlights in the Excel sheet the current cell only in the colour you 
select. 

 
 

 Add ‘cost cell’ to Uncertainty  

This command provides a short method that bypasses the 3 PE tab covered in 
4.1.6 that is it enables you to transfers the current cell to the Uncertainty 
Drivers list. 
 
 
 

 Add ‘cost cell’ to Risk  

This command provides a shortcut method that bypasses the Risk feature covered 
in 4.1.8 that is it enables you to transfers the current cell to the Uncertainty 
Drivers list. 

4.3 Driver Details panel 

The Driver Details panel allows you to edit or enter the Name and Comments. 
Click Save after editing the fields. Either filed may be inserted into the Excel 
cell’s comments field by using the Feature Bar commands previously described. 
 

4.4 Input Control Slider Panel 

 
 
This panel allows you to flex multiple rows so that the change the “Key Output 
Cell” (KOC) can be calculated.  
Use the ‘shift’ or ‘Ctrl’ keys to select multiple Drivers on the Sensitivity Drivers 
panel and then drag the Flex Control Slider to manipulate the inputs as a group. 
The inputs will be manipulated by the same percentage of their original values. 
The resulting effect on the KOC is displayed in the Watch Output Cells panel. 
Subsequent groups of inputs may then be selected and flexed to build-up a 
scenario.  
 
For example, a group of durations may be selected and manipulated using the 
slider to simulate an overall increase in the time required to perform tasks. Once 
this effect has been applied, a group of rates or overheads may be adjusted 
downward to reflect the changes possible as a result of more hours and the 
overall effect will be displayed in the Watch Output Cells panel. 
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: 
 

: The workbook will be dynamically updated with the flexed input data. 
You can save your scenarios either by saving the workbook as a different 
filename or by over-writing the original workbook. 
 

: The application has already made a backup of the original workbook in 
the source folder with a time and date extension that can be kept or deleted on 
close. 
 

: This function is extremely useful when conducting real time 
negotiations and demonstrating to Management the effects of changes.  
 
The slider control allows the flexure of multiple Driver inputs simultaneously. 
Watch Output Cells 
The Watch Output Cells panel allows the monitoring of multiple workbook 
outputs simultaneously as the Driver Inputs are manipulated. Initially, only the 
Key Output Cell is loaded as the first entry to this control and can be identified 
by the title of the output response window (for example [key output cell = 
‘abc’]).  As the inputs are manipulated and the KOC is affected the background 
colour will change to Red or Green as the KOC increases or decreases in value 
respectively. 
 

 
 
To add further outputs to the list, right-click on the Output response window and 
the Output response contextual menu options will appear. 
 
 
Click on the ‘Add Output cell(s) to watch’ option and the following dialog box 
will open. 
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Select the cell you want to watch in Excel and click OK. The output will be added 
to the list. You can repeat the process to select multiple outputs for display in 
the list. 
As the inputs are manipulated you can see the individual output values changing 
in the watch-window. 
 
To remove entries from the watch-window right click on the required cell and 
select “Remove ‘sheet cell ref’ from watch list” on the Output response menu. 
 
The Show ‘sheet cell ref’ in key results command will add the cell to key 
results in the Excel sheet.  
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5 Uncertainty function tab 

 
Uncertainty can be described as: 
 
‘A cause of volatility in outcome – excluding risk and opportunity factors’ 
 
Uncertainty can be used to express and quantify: 
 
•  Lack of knowledge regarding input data. 
•  Known boundaries of estimation error. 
•  Poor provenance or immaturity of data quality. 
 
It can be difficult to gauge (or get anyone to commit to) a single-point estimate. 
People are generally more comfortable with a range of input and this is the 
aspect that Uncertainty facilitates. 
 
•  In theory, the number of data points for Uncertainty is unlimited and could 

be described by continuous distribution with up to 101 points. 
•  Most commonly, variable estimates have two or three points, ranging 

between Minimum, Expected and Maximum values. 
•  Whilst we must take care not to mandate three data points in all cases the 

common term for the Uncertainty assessment process is Three-Point 
Estimation 

 
Three-Point Estimation is a quantitative analysis technique that assigns numerical 
values to define a range of possible out-turns so that ‘Risk Analysis’ may be 
carried out to better inform decisions. In forecasting terms, a Three-Point 
Estimate is an estimate of the range of possible out-turns from a Minimum to a 
Maximum; with the Expected out-turn located between these two extremes.  
 
3PEs (generally) consist of three values and an associated distribution; 
 
•  Minimum possible value 
•  Expected Out-turn Value 
•  Maximum possible value 
•  Distribution Type (Shape) 
 
It is a methodology for describing the valuation and limits of Uncertainty that 
surround forecasts in a format suitable for subsequent Monte Carlo analysis.  
 
Three point estimates (3PE) have become the current standard for both 
variability assessment parameters because; 
 
•  The Customer now requires them in certain sectors, 
•  They provide an significant additional level of granularity to input data whilst 

imposing minimum overhead on the costing process, 
•  They engage an additional thought process which has the effect of making 

the estimate more robust, easier to audit and validate. 
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To access fields and controls related to uncertainty click once on the Uncertainty 
Function Tab. 
 

 
 
The main window on the Uncertainty tab displays a summary of the Uncertainty 
parameters beneath the Features Bar with its Uncertainty-related controls. 
Each row in the list of Uncertainty Drivers pertains to one input cell in the 
attached Excel workbook and summarises the applied Uncertainty assessment. 
 
Each column contains a parameter pertaining specifically to the cell selected. 
The Uncertainty Drivers list may be sorted by any column alphanumerically 
ascending or descending by clicking on the column header description title. 
 
Column headings are: 

 Metadata:  
o Name of Input Cell: If there is a cell name in Excel 
o Worksheet: Location of the Cell in the Workbook 
o Cell: Location of the Cell in the Worksheet 
o Input Cell Value: Single-point (constant) value from Excel 

 Assessment Parameters:  
o Level: Qualitative level assessment (H, M, L, etc.) 
o Shape: Quantitative distribution type (Uniform, Triangular, etc) 
o Min: Quantitative lowest possible value for 3PE 
o Likely: Quantitative most likely value for 3PE  
o Max: Quantitative highest possible value for 3PE  

 Comments: Text field for capturing notes and assumptions re. cell 
 

: The total number of Uncertainty Driver cells is displayed above the 
summary pane underneath the Feature Bar: 
 

 
 

Parameter summary 
Edit Parameters 

Associated 
Risk / 

Correlation 
Data 

           Metadata        
     Assessment 

Info. 
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5.1.1 View or edit Uncertainty assessment parameters 

The following Edit instructions apply irrespective of the method used to add or 
import the Uncertainty Drivers to the list. To access a cell’s uncertainty 
parameters click once on the row containing the cell you wish to view or edit. 
The Uncertainty parameters will be displayed in the lower left pane of the 
Uncertainty Function Tab. 

 View Uncertainty Metadata 

Metadata pertaining to the cell is displayed to the left side of the Uncertainty 
parameters pane. The only metadata that may be edited by the user is the 
Comments field. This is a text field with a character limit of 1024. 
Once the Comments field is populated or updated click Save to commit changes. 
 

 
 
Comments saved here will also be visible in the Comments field in the 
Uncertainty Drivers summary list, in the Comments field on the Sensitivity 
Function Tab and may also be inserted as a comment into the attached workbook 
on the relevant cell as a record external to the application. 
  

    Metadata  Parameters  
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 Apply or edit QUALitative Assessment Parameters 

The application provides a unique ability to assign Uncertainty by applying a 
qualitative level to the cell. Qualitative assessment parameters are described in 
detail in Section 8. When the qualitative level is applied to the target cell the 
quantitative parameters, such as a three-point estimate, are automatically and 
dynamically calculated relative to the cell’s value. 
 
To apply a qualitative Uncertainty assessment to a single cell: 
1. Select the cell row to which you wish to apply the assessment level 
2. In the Uncertainty parameter pane, select the Qualitative button 
3. In the type selector box, select Relative levels 
4. Select the level you wish to apply from the level drop-down box 
5. Click Save. The assessment is applied and the Level is displayed in the main 

Uncertainty Drivers list. 
 

 
 

The information (circled in yellow) shown below the qualitative selection 
is an illustration of the factors that describe the distribution that will be applied 
the deterministic value, it does not use those numbers for any other purpose. 
 
To apply a qualitative level to multiple cells at the same time: 
1. Hold down the Ctrl key and click once on each row you want to select 
2. Repeat the qualitative level selection process above and click Save. 
3. The assessment level is applied to each of the selected cells and the Level is 

displayed for each selected cell in the main Uncertainty Drivers list. 
 

  
 
 

: The calculation of Uncertainty Driver Mean Impact (See section 5.9) is 
not possible for cells that have a qualitative assessment applied. 

Qualitative 
Level 

Assessment 
Summaries 



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 43 

 Apply or edit QUANTitative Assessment Parameters 

Quantitative Uncertainty assessments may be made using several standard input 
distributions that are listed and described fully in Section 8. 
 
To apply a quantitative Uncertainty assessment to a single cell: 
1. Select the cell row to which you wish to apply the assessment level 
2. In the Uncertainty parameter pane, select the Quantitative button 
3. Select the distribution Shape you wish to apply from the Shape drop-down 
4. Type in the Minimum, Likely and Maximum values you wish to apply (the  
5. Click Save. The assessment is applied and the parameters are displayed in the 

main Uncertainty Drivers list. 
 
 

 
 
To apply quantitative parameters to multiple cells at the same time: 
1. Hold down the Ctrl key and click once on each row you want to select 
2. Repeat the qualitative level selection process above and click Save. 
3. The assessment parameters are applied to each of the selected cells and are 

displayed for each selected cell in the main Uncertainty Drivers list. 
 

  
  Quantitative 

Parameter 
Assessment 
Summaries 
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5.2 View function  

This command allows you to change which Drivers are displayed in the main 
Sensitivity Drivers panel: 
Options: 

 Parameters Formatted – display as per MS Project 

 Parameters Sortable- will convert different units to a constant 

: Use with Caution 

 Parameters relative Sortable- will display in Relative terms  

: Use with Caution 
 

 Drivers Sensitivity Tornados 
o Relative 
o Absolute 

 

 Filter 
o Top ‘N’ inputs 
o Above a Percentage 
o Working inputs   
o Non- working inputs 
o With Positive effect 
o With Negative effect 
o Above a certain value 
o All 
o Worksheets 
o Remove Filter 

 Driver category 
o Filter 
o Remove Filter 
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5.3 Data function 

 
 

5.3.1 Add Cells selected from Excel 

To add uncertainty by manually selecting cells from the attached workbook: 
1. Click once on the Data tab on the Uncertainty Feature Bar 
2. Select Add Cells selected from Excel from the drop-down list. The cell-

selector will be displayed in Excel over the attached workbook: 
 

 
 
3. Select the cells to which you want to add uncertainty parameters. The cell 

locations or ranges will be displayed in the cell-selector window. Click OK. 
 

 
 

4. A progress indicator appears and a confirmation message is displayed once 
the task is finished. Click OK to complete the operation. 

5. The cells are now displayed in the main Uncertainty Drivers pane with their 
names, locations and deterministic values. Note that the shape column is 
highlighted in red denoting that although the cell is available for uncertainty 
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assessment it currently has no parameters assigned to it. 
 

5.3.2 Import parameters 

 

 From data in this workbook 

5.3.2.1.1 Grab 3PE Uncertainty from columns in worksheet 

To grab 3-point estimate uncertainty input data from the attached workbook: 
1. Click once on the Data control on the Uncertainty Tab > Feature Bar 
2. Select the Import parameters > From data in this workbook option. The 

input dialog appears: 
 

 
 
 

3. Select the Columns option. If you have defined the distribution shape by 
typing its initial to the left of the max value select the Include Shape box. 

4. Click Select. The cell-selector is displayed in the attached workbook.  
5. Use the mouse to select only the Likely values in the column. 

 The application expects the min and max values to be adjacent 
(either side) so you don’t have to select them all, as shown in the graphic 
below. 
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6. Once you have selected the Likely cells click OK. 
7. A progress indicator appears and a confirmation message is displayed once 

the task is finished. Click OK to complete the operation. The selected cells 
are added to the Uncertainty list, the 3PE parameters are applied and the 
new selections are displayed in the main Uncertainty Drivers list. 

 
 

5.3.2.1.2 Grab 3PE Uncertainty from rows in worksheet 

To grab 3-point estimate uncertainty input data from the attached workbook: 
1. Click once on the Data control on the Uncertainty Tab > Feature Bar 
2. Select Import Parameters>From data in this workbook option. The input 

dialog appears: 
 

 
 
 

3. Select the Rows option. If you have defined the distribution shape by typing 
its initial to the left of the max value select the Include Shape box. 

4. Click Select. The cell-selector is displayed in the attached workbook.  
5. Use the mouse to select only the Likely values in the row. 
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 The application expects the min and max values to be adjacent 
(above & below) so you don’t have to select them all, as shown in the graphic 
below. 

 

 
 
6. Once you have selected the Likely cells click OK. 
7. A progress indicator appears and a confirmation message is displayed once 

the task is finished. Click OK to complete the operation. The selected cells 
are added to the Uncertainty list, the 3PE parameters are applied and the 
new selections are displayed in the main Uncertainty Drivers list. 

 

 Input Uncertainty by import from an Uncertainty Register 

To import Uncertainty from an external register in an Excel workbook: 
 
2. Ensure the external register is prepared and saved in the following format:  

 

 
 
(the cell name is optional but can be used instead of the Cell Reference to allow 
consistent parameter application where the target cell reference is not 
consistent between workbooks. 
3. Click once on the Data control on the Uncertainty Tab Feature Bar 
4. Select Import Parameters then From external register (.xls) option.  
5. Select the file name and location from the displayed file-browser window  
6. Click Open. 
7. A progress indicator appears and a confirmation message is displayed once 

the task is finished. Click OK to complete the operation. The imported 
information is added to the Uncertainty list and displayed in the main 
Uncertainty Drivers list. 

  

Cell Reference Name Level Minimum Likely Maximum Shape Whole

'Cost Model'!H6 Hrs_Ship1_Design 50 150 Uniform FALSE

'Cost Model'!H7 Hrs_Ship1_Proc 50 100 150 Triangular FALSE

'Cost Model'!H8 Hrs_Ship1_ILS 75 100 125 Beta FALSE

'Cost Model'!H9 Hrs_Ship1_OpsMan 0.1 50 0 Normal FALSE

'Cost Model'!H5 Hrs_Ship1_PM High
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 Generate an Uncertainty Register import template 

The application contains a function to generate for the user a new workbook 
with a pre-configured risk register import template for easy population. 
 
To generate the risk register import template in new workbook: 

 
1. Click once on the Data control on the Uncertainty Tab Feature Bar 
2. Select Import Parameters then Generate external register (.xls) template 

option. 
3. A new Excel workbook will be created which contains the pre-configured 

template layout. Populate the template with uncertainty data and be sure to 
extend the Excel Name Range ‘Uncertainty’ to include all new line items. 

 

5.3.3 Export parameters 

 

 Paste to this workbook 

This will you add Arrisca values to Excel workbook 

 Select paste to this option 

 Fill in popup “paste back” options 

 Note addition values can be added as rows or columns with offsets 

. 

 Export to Current Workbook 

This allows you to export uncertainties to the current workbook as a new 
worksheet. 

 Select To current workbook from Data> Export Parameters 

 A popup option box will allow to change the name of worksheet if 
required, sheet is pre name by the Arrisca tool , press OK to finish 
operation. 
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 Export To External Workbook as an uncertainty register 

To export Uncertainty to an external register in a new Excel workbook: 
1. Click once on the Data control on the Uncertainty Tab Feature Bar 
2. Select Export Parameters then To external register (.xls) option.  
3. Select the file name and location in the displayed file-browser window  
4. Click Save. 
5. A progress indicator appears and a confirmation message is displayed once 

the task is finished. Click OK to complete the operation. 
 
The Uncertainty parameters are exported in the following format: 

 
 
The parameters may be edited, extended or reduced as required in Excel and 
then re-imported into the application using the Uncertainty Tab  Feature Bar 
Data > Import Parameters  > From external register (.xls) control described in 
Section 5.3 
 
 

5.3.4 Remove Uncertainty  

Uncertainty may be removed by one of two methods: 

 All 

 Selected rows only 
 
To remove all uncertainty assessments and clear the Uncertainty Driver list: 
1. Click once on the Data on the Uncertainty Tab  Feature Bar then select 

Remove uncertainty  
2. Select the All option 

3. A progress indicator appears and a confirmation message is displayed once the 
task is finished.  
To remove selected uncertainty assessments and remove them from the 
Uncertainty Driver list: 
1. Select the rows representing the cells you want to remove from the 

Uncertainty Drivers list 
2. Click once on the Data on the Uncertainty Tab Feature Bar 
3. Select the Remove uncertainty then Selected rows option 
4. A progress indicator appears and a confirmation message is displayed once 

the task is finished.  

Cell Reference Name Level Minimum Likely Maximum Shape Whole

'Cost Model'!H6 Hrs_Ship1_Design 50 150 Uniform FALSE

'Cost Model'!H7 Hrs_Ship1_Proc 50 100 150 Triangular FALSE

'Cost Model'!H8 Hrs_Ship1_ILS 75 100 125 Beta FALSE

'Cost Model'!H9 Hrs_Ship1_OpsMan 0.1 50 0 Normal FALSE

'Cost Model'!H5 Hrs_Ship1_PM High
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5.3.5 Activate Uncertainty 

To deactivate uncertainty assessments and clear the Uncertainty Driver list: 
4. Click once on the Data on the Uncertainty Tab  Feature Bar then select 

Activate uncertainty  
5. Select the All option 
6. A progress indicator appears and a confirmation message is displayed once 

the task is finished. View “Active” column to confirm operation. 
 
To remove selected uncertainty assessments and remove them from the 
Uncertainty Driver list: 
5. Select the rows representing the cells you want to remove from the 

Uncertainty Drivers list 
6. Click once on the Data on the Uncertainty Tab Feature Bar 
7. Select the Activate uncertainty then Selected rows option 
8. A progress indicator appears and a confirmation message is displayed once 

the task is finished. View “Active” column to confirm operation. 
 

5.3.6 Deactivate Uncertainty 

To deactivate uncertainty assessments and clear the Uncertainty Driver list: 
7. Click once on the Data on the Uncertainty Tab  Feature Bar then select 

Deactivate uncertainty  
8. Select the All option 
9. A progress indicator appears and a confirmation message is displayed once 

the task is finished. View “Active” column to confirm operation. 
 
To remove selected uncertainty assessments and remove them from the 
Uncertainty Driver list: 
9. Select the rows representing the cells you want to remove from the 

Uncertainty Drivers list 
10. Click once on the Data on the Uncertainty Tab Feature Bar 
11. Select the Deactivate uncertainty then Selected rows option 
12. A progress indicator appears and a confirmation message is displayed once 

the task is finished. View “Active” column to confirm operation. 
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5.4 Risk 

 
 

5.4.1 Show all Risks 

By default any risk associated with the cell row highlighted in the Uncertainty 
window will be displayed in the ‘Risks’ window in the bottom right of the 
Uncertainty screen. The ‘show all risks command will display all risks associated 
with any uncertainty row in the small window. 
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5.4.2 Add selected Uncertainties  

The cells highlighted will be added to the risk tab as impacts associated with 
either an extant or newly created risk.  

 Select the row that you wish to add the impact values. 

 Click Risk tab then Add Uncertainty. 

 A popup “define selected Uncertainty Impacts” will appear 

 Complete the Probabilty either as Quantitative percentage value  or 
Qualitative statement. 

 Complete Assessment with impact values (quantitative) or percentage 
impact (Relative) . This is impact the risk may have on the selected 
element not to be confused with the 3PE uncertainty estimate. If you 
unable to define values, click Qualitative and use statements from the 
dropdown menu to define impact. 

 Press Save and Close button  
 

 

5.4.3 Add All uncertainties  

All cells that have uncertainty will be added to the risk tab as impacts associated 
with either an extant or newly created risk. 

 Click Risk tab then Add ALL Uncertainty. 

 A popup “define selected Uncertainty Impacts” will appear 

 Complete the Probability either as Quantitative percentage value  or 
Qualitative statement. 

 Complete Assessment with impact values (quantitative) or percentage 
impact (Relative). This is impact the risk may have on the all the elements 
not to be confused with the 3PE uncertainty estimate. If you unable to 
define values, click Qualitative and use statements from the dropdown 
menu to define impact. 

 Press Save and Close button 
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5.5 Correlation  

Correlation between any uncertainty inputs can easily be applied from the 
Uncertainty Drivers List and managed from the Associated Correlations box. 
 

Correlation is the expression of interaction between variables. 
•  Correlation is used to describe the derivative effect of the variation of 

nominated ‘lead’ elements on ‘dependent’ elements during analysis. 
•  Correlation can be used to make variables ‘follow’ or ‘repel’ each other to a 

degree specified by what is called the Coefficient of Correlation. 
•  The relationship between the variables may be described as either Direct or 

Inverse depending on the nature of effect. 

5.5.1 Add correlation to Uncertainty Driver cells 

In the Uncertainty Drivers list on the Uncertainty Function Tab: 
1. Select the Uncertainty Driver rows you wish to correlate using the Ctrl key 
2. Right-click once on one of the selected cells and a menu appears 
3. Select the Add Correlation with uncertainty of ‘Cell x’ option 

 

 
 

 
 
 
 
 
4. The Correlation dialog box will appear. From here you can change either the 

cells to be correlated or the degree of correlation to be applied. 
 

Risk & 
Correlation 
Panel  

Right Click menu  

 Correlation 
dialog box  
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5. Using the Change button select the desired cells and degree of correlation 
selected, click once on the Apply button to commit the correlation to the 
simulation. 

The Associated Correlations panel will be populated.  

Parameter Inputs: 
•  Lead variable 
•  Tracking variable (s) 
•  Correlation coefficient (value = -100% through +100%) 
•  Any degree of Direct or Inverse correlation can be specified, with the 

greatest effects at the -100%/+100% limits. 

5.5.2 Add correlation when grabbing Uncertainty from workbook 

 
In the Get 3PE from workbook function as described in Section 5.2, check the 
box for Correlate Selected Range of Cells before import. 
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5.5.3 Remove correlation from Uncertainty Drivers 

In the Associated Correlation window select the correlated items you wish to 
remove then right click verify action by clicking the remove selected popup box 
 

 

5.5.4 Update Correlation 

In the Associated Correlation window select the correlated items you wish to 
change right click verify and verify update Coefficient selected. A popup menu 
will appear displaying details of the correlated items selected, type in new 
coefficient a value between -1 and +1 (1=100%) 
 

 

 

 

5.5.5 Show All 

This function control what is displayed in Risk/Correlation panel (btm. right hand 
of screen) 

 Select Correlation from Uncertainty function tab 

 Select Show All to display all the items that are correlated. 

5.5.6 Remove All 

This function control what is displayed in Risk/Correlation panel (btm. right hand 
of screen). 

 Select Correlation from Uncertainty function tab 

 Select Remove All to remove correlated items from display. 
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5.5.7 Remove Selected 

This function removes selected items from view. 

 Using Ctrl key and left click select items to be removed. 

 Select Correlation from Uncertainty function tab 

 Select Remove Selected to remove correlated items from display. 

5.5.8 Export 

Will export the correlation data to an Excel workbook 

 Select Correlation from Uncertainty function tab 

 Select Export, you be ask to Name the file then press Save, this will 
create a new workbook in the format shown below. Remember to fill in 
Excel with metadata and Save. 
 

 

5.5.9 Import 

Will Import Correlation data from an Excel workbook 

 Select Correlation from Uncertainty function tab 

 Select Import> select file from Import manager. 
 

: file must be in the format shown above. 
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5.6 Get 3PE from workbook 

There are certain common layouts of Uncertainty values in a spreadsheet. 
The application provides the ability to ‘grab’ this data from the spreadsheet. 
The two most common layouts are: 
 

 Columns – where the minimum & maximum values are in adjacent cells to the 
left and right of the likely value, laid out as in the following graphic; 
 

 
 
and  

 Rows - where the minimum & maximum values are in adjacent cells directly 
above and below the likely value, laid out as in the following graphic; 
 

 
 
The cells may be grabbed either individually, as contiguous or non-contiguous 
selections or by ranges. The main purpose of this feature is to ‘grab’ large 
amounts of 3PE input data in one go. It is quite normal to select a range of cells 
containing many thousands of 3-point estimates to import by a single click. 

5.6.1 Grab options for 3PE Uncertainty import from worksheet 

As well as grabbing the 3-point estimate cells and parameters from the workbook 
it is possible to carry out additional functions during the process: 

 Also include shape – allows specification of distribution to be applied. 
Simply ensure the initial letter of the distribution is included to the right of 
for Columns or below for Rows. Common shapes, with parameters, are: 

o C = Constant (Likely) 
o U = Uniform (Min, Max) 
o T = Triangular (Min, Likely, Max) 
o B = Project Beta (Min, Likely, Max) 
o N = Normal (Sigma = Std Deviation, Mu (Mean) ) – Use Distribution tool 

to establish Mu & sigma value see Sect 9.1.3 
o L = Lognormal (Sigma = Std Deviation, , Mu (Mean), deterministic ) – 

Use Distribution tool to establish Mu & sigma value see Sect. 9.1.3 
 

 Also add as Key Result – This option adds the Likely cells to the list of Key 
Results as part of the grab process. This results in statistical data being 
calculated for all of the likely cells during a Monte Carlo simulation and the 
subsequent paste-back of the statistical confidence-related values. 
 

 Ignore zeros – this option identifies and ignores zero-value likely cells during 
the grab process, reducing the number of nugatory cells that are imported 
and displayed in the Uncertainty Drivers and Key Results lists. 

 



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 59 

5.7 Add Uncertainty by Driver manipulation 

Uncertainty may be added by recording the manipulation of the Sensitivity 
Drivers on the Sensitivity Function Tab.  
To add Uncertainty from manipulation of the Sensitivity Drivers: 
1. Ensure that a Driver Analysis (see section 3) has been run in Start function. 
2. Navigate to the Sensitivity Function Tab by clicking once on the tab 
3. Select the Drivers to be flexed and added to the Uncertainty List 
4. Set Likely values: 

i. Use either the Manual Flex Control Slider or the + or - Flex 
Buttons to manipulate the selected drivers to a desired state 
which represents a set of Likely Uncertainty values 

ii. On the Feature Bar, select the Apply Flex Values control 
iii. Select Selected and most Likely 
iv. A progress indicator appears and a confirmation message is 

displayed once the task is finished. Click OK to complete.  
v. The Driver cells have been added to the Uncertainty Drivers List 

on the Uncertainty Function Tab with a Constant shape of the 
value set by the flex manipulation 

5.  Set Minimum values: 
i. Use either the Manual Flex Control Slider or the + or - Flex 

Buttons to manipulate the selected drivers to a desired state 
which represents a set of Minimum Uncertainty values 

ii. On the Feature Bar, select the Apply Flex Values control 
iii. Select Selected and Minimums 
iv. A progress indicator appears and a confirmation message is 

displayed once the task is finished. Click OK to complete.  
v. The Minimum values have been added to the parameters on the 

Uncertainty Drivers List on the Uncertainty Function Tab. The 
shape is now indeterminate and is highlighted in red. 

6. Set Maximum values: 
i. Use either the Manual Flex Control Slider or the + or - Flex 

Buttons to manipulate the selected drivers to a desired state 
which represents a set of Maximum Uncertainty values 

ii. On the Feature Bar, select the Apply Flex Values control 
iii. Select Selected and Maximums 
iv. A progress indicator appears and a confirmation message is 

displayed once the task is finished. Click OK to complete.  
v. The Maximum values have been added to the parameters on the 

Uncertainty Drivers List on the Uncertainty Function Tab. The 
shape is now Triangular and the assessment is complete. 
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5.7.1 Options  

Apply Comments to workbook cells; any comments that have been added and 
saved to the Uncertainty Driver list may subsequently be inserted into the 
comments field of the workbook cells. 
 
To apply the comments to the workbook: 

 
1. Ensure you have recorded and saved comments in the Uncertainty Drivers 

(comment text is visible in the Comments column to the right of the list) 
2. Click once on the Options control on the Uncertainty Tab  Feature Bar 
3. Select Apply Comments then select either All, Listed or Select option 
4. A progress indicator appears and a confirmation message is displayed once 

the task is finished. Click OK to complete the operation. The comments have 
now been inserted into the relevant cells in the workbook. Any existing 
comments for each cell have been appended not replaced. 

 

5.8 View the impact of Uncertainty 

 
 
To understand the impact the drivers that have associated uncertainty select the 
Uncertainty Driver Analysis feature tab this refresh the viewing panel with new 
information; the new columns are: 

o Outcome Volatility-  The drivers total possible impact on the grand 
total i.e. The selected cell chosen as the “Key Output cell” 

o Cell Volatility- The drivers overall percentage impact. 

o Likely Offset-  The drivers total impact in units of base 
assessment (units of the target cell in workbook) 

o Effect@Min  The drivers minimum effect in base units 

o Effect@Max  The drivers max effect in base units 

: Use View > Parameters Formatted to switch viewing panel back to 3PE 
value view. 
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There is a known issue regarding Effect@Max if the software has gone 
through several load and reload files cycles the values shown are the same for 
each row, if this occurs it is necessary to use Tools> clear or in extreme 
circumstances reboot the computer.    

5.9 Quantitative  Conversion 

 
If you have used any form of Qualitative assessment it will necessary to covert 
Qualitative to a Quantitative value 

 Select Quantitative Conversion  from the Uncertainty function 

 Select All or pre select a row(s) from the viewing panel, use Ctrl+Click to 
select more than one row. 

5.10 Associated Risk Drivers window 

Cells that have Uncertainty parameters may also have risk parameters attached. 
The Associated Risk Drivers window allows the user to see what risk or 
opportunities may be associated with the cell selected in the main list. 
 
 

 
 
 

If risk drivers exist for the selected cell, use the  
+ or – controls to expand or collapse the risk driver impact list. 
 
To access the risk drivers associated with the cell: 
1. Right-click on the name of the risk in the associated risk drivers pane 
2. Select Goto [name of risk driver] 

Risk & Correlation Panel  
Displaying risk associated with 
uncertainty 
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3. The Risk and Opportunity Function Tab is displayed and the associated risk 
driver is selected and its parameters are displayed. 

 

 

 Sensitivity Driver panel contextual menu (right-click)  

There are a number of options available by making a right mouse click menu 
within the driver panel, as shown below:   

 

5.10.1.1.1 Goto this cell in workbook 

 Goto this cell in workbook – selects and focuses target cell 
 

: This is a quick way of finding the Driver inputs in the Excel 
workbook. 

 

5.10.1.1.2 Driver Actions sub menu 

The following options are available: 
 

 Reset – returns this cell to its original Excel values comments and names 
added are not affected. 

 Exclude cell from sensitivities – inserts an ‘=’ sign as a prefix to cell 

 Hide – hides cell from Drivers list 

 Unhide restores hidden rows 

5.10.1.1.3 Apply sub menu 

This command transfers the current cell value to the Uncertainty assessment, 
full flex instruction are detailed in 4.1.7.; options are available: 
 

 Minimum – applies current flex value to Uncertainty minimum value 

 Likely – applies current flex value to Uncertainty likely value 

 Maximum – applies current flex value to Uncertainty maximum value 
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5.10.1.1.4 Highlight menu 

This command highlights in the Excel sheet the current cell only in the colour you 
select. 

 

5.10.2 Uncertainty panel contextual menu (right-click) 

Select the row from uncertainty display panel, there are a number of options 
available by making a right mouse click menu, as shown below:   
 

 

 Add Goto this cell in workbook 

 Goto this cell in workbook – selects and focuses target cell 
 

: This is a quick way of finding the Driver inputs in the Excel 
workbook. 

 

 Remove Selected 

 Remove rows from uncertainty calculations. 

 Add Correlation with cell (selected row)  

This command provides a shortcut to correlation method detailed in 5.7.7  
 
Add ‘selected cell’ to Risk  
This command provides a short method that bypasses the Risk feature covered in 
4.1.8 that is it enables you to transfers the current cell to the risk Drivers list. 

 Convert selected to quantitative  

Converts selected row from qualitative (%) to values 
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 Activated selected 

Include row in calculations. 
 

 Deactivate selected 

Exclude selected row from calculations  

  

 
 

6 Risk and Opportunity function tab 

 

6.1 Risk  

As far as the term Risk is used you may consider the word Opportunity to be 
exchangeable where the effect of the impact is of the opposite polarity. 
 
The differentiator between Risk (and Opportunity) and Uncertainty is the 
Probabilistic element – also known as Likelihood. 
 
In risk, for there to be a Likelihood of occurrence, recorded as Probability on a 
scale of 0% - 100%, there must be an associated event or root-cause for the 
impact to manifest. 
 

 Opportunity is utilised by the tool as being a negative “risk” value eg. 
 Min -700, Most Likely -500 and Max -200 
  



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 65 

 
 

 
 
Pre Simulation view 
 
 

 
 
Post simulation view 
 
Risk Display 
The main window on the Risk and Opportunity tab displays a summary of the Risk 
Driver parameters beneath the Features Bar with its risk-related controls. 
Each row in the list of Risk Drivers pertains to one Risk or Opportunity. The total 
number of risk drivers in the system is shown at the top of the Risk Drivers list in 
the Risk Driver Summary Bar. The colour of the Risk Driver Bar in post simulation 
display is indicative of the polarity of effect of the aggregate risk driver list: 
 

 Red – the effect of the drivers is to increase the overall outturn value 

Assessment 
Parameters 

  

 Impact Drivers 

Risk Drivers  

Risk Driver metadata  

Assessment 
Parameters 

  

Risk Drivers  

 Impact Drivers 

Risk Driver metadata  
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 Green - the effect of the drivers is to decrease the overall outturn value 
 

 : It is subjective as to whether an increase or decrease in the outcome 
represents good / bad, red / green, or risk / opportunity – dependent on your 
perspective – therefore the colours that represent increase and decrease are 
configurable in Settings and Configuration. See Section 8 for details. 
 
Each row in the Impact Drivers list pertains to an impact that acts on an input 
cell in the attached Excel workbook. 
 
Each column contains a parameter pertaining specifically to the risk selected. 
The Risk Drivers list may be sorted by any column alphanumerically ascending or 
descending by clicking on the column header description title. 
 
Column headings are: 

 Risk Driver List:  
o Code: Unique risk identifier (optional) 
o Active: Indicates if the risk is active during simulation 
o Name: The high-level short-name of the risk 
o Scatter / Blanket: Indicates probability dependence 
o CCI: Context Critical Impact – the risk outcome in common units 
o TCI: Total Critical Impact – non-probabilistic risk outcome in common 

units 

 Impact Driver List:  
o Worksheet: Location of the Cell in the Workbook 
o Cell: Location of the Cell in the Worksheet 
o Probability Level: Qualitative Probability Level (if applied - HML) 
o Probability: Quantitative probability (as integer: scale 0-100) 
o Impact Level: Qualitative Impact Level (if applied - HML) 
o Shape: Quantitative distribution type (Uniform, Triangular, etc) 
o Min: Quantitative lowest possible value for 3PE 
o Likely: Quantitative most likely value for 3PE  
o Max: Quantitative highest possible value for 3PE  
o CCI: Context Critical Impact – the risk outcome in common units 
o TCI: Total Critical Impact – non-probabilistic risk outcome in common 

units 
o MCI: Mean Critical Impact – actual mean impact of risk in units of base 

assessment (units of the target cell in workbook) 
 

6.2 View 

 
 
Tool is Factory set at Unformatted view only 
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6.3 Data 

 

 

 Create a new risk  

 
To add a Risk Driver by manual entry, follow the following 3-point procedure: 
 
 
 
 
 
 
 
 
 
 
 

Risk may be added in one of three ways: 

 Add by manual entry 

 Import from cells in the attached workbook 

 Import from a separate Risk Register 
 

6.4 Create New Risk (manual entry) 

 

R 
 

Create 
Risk 

Driver 

I 
 

Add 
Impact  

Driver 

P 
 

Make 
Parameter 

Assessment 
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6.4.1 To add a Risk Driver by manual entry: 

1. Click once on the Data control on the Risk and Opportunity Feature Bar then 
select Create New Risk . The Risk Add Driver will pop up: 

a. Type the Name of the new risk driver (mandatory), 
b. Enter the Risk Code, if applicable (optional) 
c. Select the Risk Manager (optional) 
d. Enter a high-level Description of the risk (Optional) 

2. Meta Data - will require you to fill the relative metadata via dropdown 
menus. These dropdown menus can be update by the user to reflect your 
Organisations policy see 10.1 for details. Alternatively menu can be change 
using the “+” alongside the dropdown menu box.  

3. Select Metadata from the pop up box Fill in the appropriate level from the 
dropdown menus 

4. Click Save. The Risk Driver is displayed in Risk Drivers List on the left and 
metadata on right. 

 
 

6.4.2 Add an Impact Driver to a Risk Driver 

On its own a Risk Driver has no effect on the analysis. It requires the application 
of at least one Impact Driver to describe its effect on the workbook model. Each 
Risk Driver may have an unlimited amount of Impact Drivers, each affecting a 
different cell in the attached workbook. In this way it is possible to build-up 
complex effects of risk and opportunity and yet measure their aggregate effect. 
 
To add an Impact Driver by manual entry: 
1. In the Risk Drivers list pane select the Risk Driver row to which the Impact 

Driver is to be added by clicking once on the desired row. 
2. Right-click once on the selected row and click on the Add Impact Cells [risk 

name] control on the context menu that appears. 
3. Switch to Excel – the cell-selector box will appear in the attached workbook. 
4. Select the input cell the Impact Driver will affect and click OK. 

 
5. A confirmation message is displayed once the Impact is added is finished. 

Click OK to complete the operation. The impact is displayed in the Impact 
Drivers List pane. The Shape column is coloured red denoting an incomplete 
or incorrect parameter set. 
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 Add an Impact Assessment to an Impact Driver 

To have an effect on the workbook during analysis an Impact Driver needs an 
Impact Assessment to describe its effect on the workbook model. Each Impact 
Driver has one impact assessment that pertains to and is quantified in the units 
of measurement of the cell to which it applies. e.g. if the cell’s units are in $ 
then the impact assessment is also in $; and if the cell’s unit is hours then the 
assessment is also in hours – not $ or the final currency of the workbook. 
 
To add an assessment to an Impact Driver by manual entry: 

 In the Impact Drivers list pane select the Impact Driver row to which the 
Impact Assessment is to be added by clicking once on the desired row. 

 The Impact Assessment Parameters pane at the base of the Risk & 
Opportunity Function Tab now relates to the selected Impact Driver. 

 Set Probability: 
a. Select either of the Qualitative or Quantitative options in probability 

sub panel.  
i. Qualitative: Select the desired Probability Level from the drop-

down list that appears to the right of the option; 
ii. Quantitative: Type in the desired Probability value ( an integer 

between 0 and 100) in the field that appears to the right of the 
option. 

 Set Impact: 
a. Select either of the Qualitative or Quantitative options in the 

Assessment sun panel.  
i. Qualitative:  

1. Select either Relative or Absolute levels; 
2. the desired Impact Level from the drop-down list that 

appears to the right of the option; 
ii. Quantitative: 

1.  Select the desired Shape from the drop-down list that 
appears to the right of the option; 

iii. Type in the desired Impact Values (min, likely, max, etc) in the 
fields that appear underneath the shape drop-down. 
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 Click Save. The Impact Driver Assessment parameters are displayed in the 
Impact Drivers List pane in their respective fields.  

 

: Any blank, inappropriate or illegal field values are highlighted in red. 
 

 
 Relative will produce values for min. most likely and max (3PE) based on 

the deterministic value used in the model. 

 Absolute option will add the deterministic value to the pre-determined 3 
PE defined by “User”. This option is best suited to “Design to cost” 
modelling when detailed risk impact information is limited. 

  



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 71 

6.4.3 Input Risk by import from cells in the attached workbook 

There are certain common layouts of Risk values in a spreadsheet. 
The application provides the ability to ‘grab’ this data from the spreadsheet. 
The most common layouts is: 
 

 
 
The risk parameters may be grabbed in one go by selecting the Names of risks. 
The main purpose of this feature is to ‘grab’ large amounts of risk input data in 
one go. It is quite normal to select a range of cells containing an entire risk 
register to import by a single click. 
 

: The Target cells must have a value of zero and if you want to 
calculate the total risk value you must create a sum total of all the risk target 
values. This total risk value can be summed with the total of the spreadsheet 
model to provide a risk-adjusted grand total value. You can select the Target 
cells as Key Results to generate individual statistical data or graphs for each 
risk. 
  

Code Name Prob Minimum Most likely Maximum Shape Target Description

AR1 Risk1 75 2,000,000 5,000,000 7,500,000 T 0 Rework required

AR2 Risk2 25 500,000 875,000 1,000,000 T 0 Rate increase

AR3 Risk3 15 600,000 1,000,000 1,250,000 B 0 Cost increase

AR4 Risk4 35 50,000 150,000 U 0 Rate increase

AR5 Risk5 15 400000 C 0 Material price



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 72 

6.4.4 Import from the attached workbook: 

 
 

 Click once on the Data  on the Risk and Opportunity Feature Bar 

 Select Import Parameters then From data in this workbook option. The cell-
selector is displayed in the attached workbook. 

 
 Use the mouse to select only the Names of the risks in a column. The 

application expects the risk parameters to be laid-out as described above so 
you don’t have to select them all, as shown in the graphic below (the 
selected cells containing the risk names are highlighted in yellow): 

 

 
 

 Once you have selected the risk Names cells click OK. 

 A progress indicator appears and a confirmation message is displayed once 
the task is finished. Click OK to complete the operation. The selected risks 
are added to the Risk Drivers list. 
 

: If your risk register is not exactly in this layout format you can create 
a template for the layout and then link the relevant cells to it. The import 
function can grab formulaic cells as well as ‘constant’ input cells. 
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6.4.5 Import from a separate Risk Register 

 
 
To import risk data from an external risk register in an Excel workbook: 
1. Ensure the external register is prepared and saved in the following format 

shown on the following page. The red box denotes the named range RISKS: 
2. Click once on the Data control on the Risk and Opportunity  Features Bar 
3. Select Import parameters then From external Workbook (.xls) option.  
4. Select the file name and location from the displayed file-browser window  
5. Click Open. 
6. A progress indicator appears and a confirmation message is displayed once 

the task is finished. Click OK to complete the operation. The imported 
information is added to the Risk Drivers list and displayed in the main list. 

 
to allow consistent parameter application where the target cell reference is not 
consistent between workbooks. 
Scatter or Blanket – scatter means all impacts of a risk instance are 
probabilistically independent – blanket means they are probabilistically linked. 
Use either Probability Level (Qualitative)OR Probability (Quantitative)– not 
both. 
Use either Impact Level (Qualitative)OR Min, Likely, Max (Quantitative)– not 
both. 
Serial or concurrent has no effect in Excel workbook modelling. 

6.4.6 Generate an External Register import template 

 

 
The application contains a function to generate for the user a new workbook 
with a pre-configured risk register import template for easy population. 
 
To generate the risk register import template in new workbook: 

 
1. Click once on the Data control on the Risk and Opportunity Feature Bar 
2. Select Import Parameters then Generate external register (.xls) 

template option. 
3. A new Excel workbook will be created which contains the pre-configured 

template layout. Populate the template with risk register data and be sure 
to extend the Excel Name Range ‘RISKS’ to include all new line items. 
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6.4.7  
Add Template to this Workbook 

 

 
1. Click once on the Data control on the Risk and Opportunity Feature Bar 
2. Select Import Parameters then  Add template to this workbook option. 
3. A Message box will inform you when complete. 

 

6.5 Export 

6.5.1 Paste to this workbook 

 
 
This command exports the set of risk parameters to the workbook in the format 
of the embedded risk register from which it was originally imported. This 
function is intended to help update the register in the Excel workbook if the 
parameters (e.g. probability or impact data) are modified in the application 
after import. 

6.5.2 To current workbook 

 

 
 
This will create a worksheet in the current workbook 
 

1. Click once on the Data control on the Risk and Opportunity Feature 
Bar 

2. Select Export Parameters then to Current Workbook 
3. A file Name box will display a suggested name for the sheet, you can 

overtype if required Press OK 
4. A message box will inform you when complete. 
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6.5.3 To External Workbook 

 
1. Click once on the Data control on the Risk and Opportunity Feature Bar 
2. Select Export Parameters then to External Workbook 
3. A Export Risks box will display Input Filename  Press Save 

 
4. A message box will inform you when complete. 
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6.6 Generate a Risk Register import template 

The application contains a function to generate for the user a new workbook 
with a pre-configured risk register import template for easy population. 
 
To generate the risk register import template in new workbook: 
 
1. Click once on the Data control on the Risk and Opportunity Features Bar 
2. Select the Generate external register (.xls) template option. 
3. A new Excel workbook will be created which contains the pre-configured 

template layout. Populate the template with risk register data and be sure to 
extend the Excel Name Range ‘RISKS’ to include all new line items. 
 

 (the impact of the risk not to be confused with the uncertainty 
estimate): Excel templates are also available online at RiskHive.com 

6.7 Edit Risk Driver information (metadata) 

To access and edit Risk Driver information (metadata): 
 
1. In the Risk Driver List pane on the Risk and Opportunity Tab, click once on 

the row of the Risk Driver you wish to edit.  
The Risk Driver Metadata in the top-right pane will display related data: 

2. Edit the Risk Driver Metadata as required 
3. Click Save. Updated Risk Driver is displayed in Risk Drivers List on the left. 

 

6.8 Edit Impact Driver parameters 

To access and edit Impact Driver information (metadata and parameters): 
 
1. In the Impact Driver List pane on the Risk and Opportunity Tab, click once 

on the row of the Impact Driver you wish to edit.  
The Impact Driver Assessment in the bottom pane will display related data: 

2. Edit the Impact Driver Metadata and parameters as required 
3. Click Save. Updated Impact Driver parameters are displayed in the Impact 

Drivers List above. 
 

6.9 Export Risk to Excel risk register 

To export Risk data to an external register in a new Excel workbook: 
1. Click once on the Data control on the Risk and Opportunity Feature Bar 
2. Select the To external register (.xls) option.  
3. Select the file name and location in the displayed file-browser window  
4. Click Save. 
5. A progress indicator appears and a confirmation message is displayed once 

the task is finished. Click OK to complete the operation. 
 
The Risk data parameters are exported in the format described in Section 6.3: 
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The parameters may be edited, extended or reduced as required in Excel and 
then re-imported into the application using the Uncertainty Feature Bar Data > 
From external register (.xls) control described in Section 5.3 
 

6.10 Remove Risk Drivers 

Risk Drivers may be removed by one of two methods: 

 All 

 Selected risks only 
 
To remove all risk drivers and clear the Risk Driver list: 
1. Click once on the Data feature on the Risk and Opportunity Tab > Feature Bar 
2. Select the Remove Risk then All option 
3. A progress indicator appears and a confirmation message is displayed once 

the task is finished. Click OK to complete the operation. 
 
To remove selected risk drivers and remove them from the Risk Driver list: 
1. Select the rows representing the risks you want to remove from the Risk 

Driver list 
2. Click once on the Data feature on the Risk and Opportunity Tab > Feature 

Bar 
3. Select Remove Risk then Selected option 
4. A progress indicator appears and a confirmation message is displayed once 

the task is finished. Click OK to complete the operation. 
 

6.11 Risk Probability  

To correlate the probabilistic parameters of Impact Drivers within a Risk Driver, 
use the Blanket Probability control in the Risk Driver Metadata pane on the Risk 
and Opportunity Tab 

 

Cell Reference Name Level Minimum Likely Maximum Shape Whole

'Cost Model'!H6 Hrs_Ship1_Design 50 150 Uniform FALSE

'Cost Model'!H7 Hrs_Ship1_Proc 50 100 150 Triangular FALSE

'Cost Model'!H8 Hrs_Ship1_ILS 75 100 125 Beta FALSE

'Cost Model'!H9 Hrs_Ship1_OpsMan 0.1 50 0 Normal FALSE

'Cost Model'!H5 Hrs_Ship1_PM High
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To correlate Impact Driver Probabilities: 
1. Select the Risk Driver for which you want to apply Blanket Probability. 
2. Check the Blanket Probability box. 
3. Set Blanket Probability value: 

a. Select either of the Qualitative or Quantitative options.  
i. Qualitative: Select the desired Probability Level from the drop-

down list that appears to the right of the option; 
ii. Quantitative: Type in the desired Probability value ( an integer 

between 0 and 100) in the field that appears to the right of the 
option. 

4. Click Save. Updated Risk Driver Probability is displayed in the Risk Drivers 
List in the pane to the left. The Scatter/Blanket column is updated. 

 

6.12 Analytical Risk Outcome metrics 

The application includes various methods of calculation of risk impact as follows: 
 

6.12.1 MCI: Mean Critical Impact Sensitivity Calculation 

Mean Critical Impact is the actual value of the mean impact of the Impact Driver 
from the statistical outcome of the Monte Carlo simulation. Its units are that of 
the cell to which the Impact assessment applies (units of the target cell in 
workbook).  
 
 

: MCI can only be displayed for the individual Impact Drivers – not for the 
Risk Drivers themselves at the higher level. 
 

6.12.2 CCI: Context Critical Impact Sensitivity Calculation 

Context Critical Impact is the outcome of the effect of applying the MCI value of 
the Impact Driver to the cell to which the Impact assessment applies – i.e. the 
difference the mean risk impact makes to the final outcome of the workbook. 

 
 CCI can be displayed for both the individual Impact Drivers and for the Risk 

Drivers themselves at the higher level.  

 At the Risk Driver level the value is derived from the combined simultaneous 
effect of all the related Impact Drivers.  

 At the Aggregate Exposure level the value is derived from the combined 
simultaneous effect of all the related Risk Drivers and Impact Drivers. 
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6.12.3 TCI: Total Critical Impact Sensitivity Calculation 

Total Critical Impact is the outcome of the effect of applying the non-
probabilistic mean value of the Impact Driver to the cell to which the Impact 
assessment applies – i.e. the difference the total risk impact makes to the final 
outcome of the workbook. 

 
1. TCI can be displayed for both the individual Impact Drivers and for the 

Risk Drivers themselves at the higher level.  
2. At the Risk Driver level the value is derived from the combined 

simultaneous effect of all the related Impact Drivers.  
3. At the Aggregate Exposure level the value is derived from the combined 

simultaneous effect of all the related Risk Drivers and Impact Drivers. 
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7 Analysis and Reports function tab 

 
Analysis and Reporting pertains mainly to the stochastic (Monte Carlo) functions 
of the application. Basic Sensitivity Driver Reports are also contained on this 
function tab. 
 
Function Tab Layout: pre simulation 

 

7.1 Key Results 

Key results are cells in the attached workbook that have been selected for 
statistical analysis during the process of Monte Carlo Simulation. By default the 
application will only calculate statistical outcomes for the Key Outcome cell. To 
generate statistical information for additional cells they must be added to the 
list of Key Results. 
 

: You must add cells to Key Results before you run a Monte Carlo 
simulation. Cells added post-simulation will NOT provide statistical outcome 
information. 

If an external register does not exist, use the Data control and then 
Export Parameter then select option. 
 
 
 
 
 
 
 
 
 
 

 Key Results 

 Simulation 
 Reports 
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View  

 
 

 Formatted – key results by cell order 

 Sortable  Will change values to pure units. Use with CAUTION 

 First N  Limit the number of key results displayed 

 All  Show all key results 

 Worksheets 

 Filter  Display by worksheet selection, using popup menu 

 Order is determine by MS database order so some cell’s may appear 
to be out of order) 

  
 

 

 Remove filter  Removes any selected worksheets 
 

 Show spreadsheet during analysis- Will make changes to the 
spreadsheet that be can be viewed during the simulation. Caution 
this will increase the time needed to perform the simulation run. 

 Highlight key Results Cell Location-  When selected a popup menu 
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Will enable to choose which colour you would like the key cell to be. 
 
 
 
 
 

 
 

7.1.1 Add Key Results to list 

Adding Key Results to the list is done by selecting cells from the attached 
workbook.  

On the Feature Bar click once on the Add Key Results from Workbook 
Button. This can also be reached via the Data feature  
The Key Results dialog box will open and present selection options: 

 

 
 

 Add all selected cells to the list 

1. Select Free Selection and click once on the Select button. The cell-
selector tool will appear and allow you to select cells to be added to 
the list of Key Results.  

2. When you click OK ALL cells that are selected will be added to the list 
of Key Results.  

3. A progress indicator appears and a confirmation message is displayed 
once the task is finished.  

4. Click OK to complete the operation. 
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: You may select an individual cell, multiple cells, contiguous groups of 
cells or non-contiguous cells (using the Ctrl key). 
 

 Add all Named Range to the list 

1. Select Named Range and click once on the Select button. The Popup 
menu will appear and allow you to select ranges (use Crtl + left click) 
to be added to the list of Key Results.  

2. When you click Apply the ranges that are selected will be added to the 
list of Key Results.  

3. A progress indicator appears and a confirmation message is displayed 
once the task is finished.  

 

  Ignore Zero-value cells when adding to the list 

1. Check the Ignore Zeros box before clicking once on the Select button to 
disregard all cells within a selection or range so that only cells with a 
numeric value are added to the list of Key Results.  

 

: You may reduce the number of nugatory cells added to the Key Results 
list by checking this option before adding the selected cells. This can help make 
the subsequent simulation faster and the reports cleaner and less cluttered. 

7.1.2 Import Key Results to list 

The ability to import a list of cell references from an external excel workbook 
provides the ability to add desired Key Results negating the need to repeat the 
selection process where a list of Key Result cell references is known and saved. 
To import a list of Key Result cell references to Excel: 

1. On the Feature Bar click once on the Data control 
2. Select Import Parameters 
3. Select From External Workbook (.xls) 
4. Select file from popup dialog screen then Open 
5. A progress indicator appears and a confirmation message is displayed once 

the task is finished.  
6. Click OK to complete the operation 
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7.1.3 Removing Key Results from list 

There are two options for removing Key Results directly from the list: 

 All 

 Selected 

 To remove all Key Results from the list 

1. On the Analysis and Reports Feature Bar, click once on the Data control 
and select Remove key results then All option from the drop-down list.  

2. A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

3. Click OK to complete the operation. 
 

 To remove selected Key Results from the list 

1. In the Key Results pane, first select the Key Result rows you want to 
remove from the list by clicking on each one.  

2. You can use the shift or Ctrl keys to select ranges or non-contiguous rows. 
3. On the Analysis and Reports Feature Bar, click once on the Data control  

select Remove Key Results then Selected option from the drop-down list.  
4. A progress indicator appears and a confirmation message is displayed once 

the task is finished.  
5. Click OK to complete the operation. 

7.1.4 Export Key Results 

 
Parameters related to Key Results may be exported from the application in two 
ways: 

 As a list of Key Result Cells to a separate Excel workbook 

 As a data-paste of statistical data values into the attached workbook 

 Export Key Results Statistical Data Values to attached 
workbook 

The ability to export the statistical data values pertaining to Key Results to the 
attached excel workbook using a paste function provides the ability to populate 
the data set with the results of a simulation and analysis with minimal effort. 
To export the list of Key Result cell references to Excel: 

1. On the Feature Bar click once on the Data control 
2. Select Export Parameters then Paste to this Workbook  
3. The Paste back control box is presented, as below: 
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4. Make your selection from the options of: 

 Selected (excel) will paste back all cells you select with the cell-
selector 

 Selected (riskHive analysis) will paste back to the riskHive analysis 
sheet 

 All Inputs will paste back to all variable input cells (constants) 

 All Outputs will paste back to all calculation cells 

 All Key Results will paste back to all cells marked as Key Results 

 By Range 
And 

 As Comment (will add a comment to each cell to be pasted) 

 As Values (will paste actual data values in matrix format) 
 

5. If you selected As Values, use the matrix control to specify where the 
data should be pasted. The origin is the centre cell of the matrix and this 
value will be pasted over the existing Key Result cell value. You can use 
the X and Y Offset fields to move the pasted fields away from the origin. 

6. A progress indicator appears and a confirmation message is displayed once 
the task is finished.  

7. Click OK to complete the operation. 

 
Warning Users will be required check that “Paste back” cells are the same 

format as the key Output cell, as the tool will only paste numbers and not cell 
format. 
  

4. Selection 
5. Matrix 



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 87 

8.  
 

: Example of Paste-back with Offset 

 
 
The Key Results are indicated with the green fill. Statistics for these values 
were generated during the Monte Carlo simulation. 
The 10%, 50% and 90% values for each Key Result were then pasted back into the 
worksheet adjacent to the deterministic values using the settings below: 
 
 
 

: Paste-back alternate statistical values or layouts 
You can paste-back values other than the 10%, 50% and 90% default by selecting 
All from the paste back menu or over typing with required inputs 
 
 
 
 
Example 1 
Paste back 10%, 50%, 90% values centred on 2 cells to the right of each key 
result: 

 
  

Element Key Result 10% value 50% value 90% value

 Total Price £114,356,157 £89,910,801 £95,528,186 £123,146,520

Risk £0 £871,449 £4,921,029 £5,818,036

 Selling Price £114,356,157 £94,162,944 £99,660,882 £127,014,411



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 88 

 
Example 2 
Paste back 5%, 60%, 95% values centred on 4 cells to the right and 2 cells down 
from output key results only: 

 
 
Example 3 
Paste back 25%, 50%, 75% values over selected key results in row format: 

 

 Export a List of Key Result Cells to an Excel workbook 

The ability to export the list of cell references to an external excel workbook 
provides the ability to edit, maintain and subsequently import the whole list of 
selected Key Results, thus negating the need to repeat the selection process. 
To export the list of Key Result cell references to Excel: 

1. On the Feature Bar click once on the Data control 
2. Select Export Parameters then To External Workbook (xls)  
3. A progress indicator appears and a confirmation message is displayed once 

the task is finished.  
4. Click OK to complete the operation. 



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 89 

7.1.5 Change Key Output Cell 

 
 
This allows you to change the output cell. This is useful when tracking sub totals. 

1. On the Feature bar select Change Key Output Cell 
2. This will open Excel and prompt you to select a new Output cell 
3. Message box to confirm action 

7.1.6 Calculate Theoretical Limits 

The MS workbook is constructed using deterministic estimates, this function 
replaces the deterministic  values with the 3 point estimates that fed the 
Hullograms with data so that the extreme values can be displayed on the graph. 

: It is important that this run before hullograms are prepared.  
 

7.1.7 Quantitative  Conversion 

 
If you have used any form of Qualitative assessment it will necessary to convert 
Qualitative to a Quantitative value 

 Select Quantitative Conversion  from the Uncertainty function 

 Select All or pre select a row(s) from the viewing panel, use Ctrl+Click to 
select more than one row. 

 

7.2 Simulation 

The application enables the user to run a meta modelling technique to simulate 
the effects of the stochastic variables, risk and uncertainty, on the workbook. 
The modelling technique used is called Monte Carlo simulation. The results of 
this simulation can be analysed to generate statistical information regarding the 
ranges of outturn of the workbook to inform the decision-making process. 
 
Whilst the simulation itself is a complex computing exercise the controls 
presented to the user are simple and straightforward. They are located in the 
bottom left of the Analysis & Reports Function Tab. 
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: To be able to run a Monte Carlo simulation the model must contain at 
least one element of either uncertainty or risk or there will be nothing to 
analyse. 
 

7.2.1 Run a new simulation set 

If the system has not yet run a simulation there is only one option available, the 
New Simulation button. 
 

 
 
To initiate a Monte Carlo simulation: 

1. Type in the number of simulation iterations required in the No. of 
iterations data entry field to the right of the button. 

2. Chose if you require to include or exclude low probability high impact 
(LPHI) risks 

3. Chose Mode - Standard will produce data suitable for good quality 
graphical and output data. Whereas Standard+ Hi Definition will provide 
data that will enable high quality graphs to be produced also the data for 
each simulation is available that records which risk are active and any 
given point.   

4. Chose to include exclude CCI calculations. 
5. Click once on the green New Simulation button. 
6. The workbook will be hidden and the simulation will begin. 
7. The Stop Simulation button is displayed- this will abort the process. 
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8. During simulation a progress indicator is displayed to track the simulation 
iterations as they are completed. An estimated time to complete is also 
displayed along with the current elapsed simulation time. 
 

 
 

9. The workbook is redisplayed once the simulation is finished and the 
statistical outcome values are displayed in the Key Results pane. The 
simulator controls now display the green New Simulation and Continue 
Simulation buttons. 
 

 
 

7.2.2 Continue a simulation set  

If the system has run a simulation you may want to continue the simulation from 
where it ended to generate more iteration data and improve the quality of the 
results. To continue a simulation set: 

1. Type in the new number of simulation iterations required in the No. of 
iterations data entry field to the right of the button. 

2. Click once on the green Continue Simulation button. 
3. The workbook will be hidden and the simulation will continue.  
4. The simulation will run until either the Stop Simulation button is clicked 

or the new No. of iterations limit is reached. 

7.2.3 Stop a simulation set  

If the system has run a simulation you may want to continue the simulation from 
1. Click once on the green Stop Simulation button. 
2. At the end of the next set of slices the simulation will end. 
3. The workbook is redisplayed once the simulation is finished and the 

statistical outcome values are displayed in the Key Results pane. The 
simulator controls will now display the green New Simulation and 
Continue Simulation buttons again. 
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7.2.4 SEED option 

 
 
The seed option allows you to use either a Random number or a Fix Seed. 
 

:Use fixed if wish to repeat a simulation that will give identical results 
each time it is run. 

7.2.5 Convergence 

 
With any statistical simulation technique you reach a point when more 
simulations runs will not improve the output results, this option allows you set 
the point at which you consider the simulation should stop. 
 

7.2.6 Stop a simulation set  

If the system has run a simulation you may want to continue the simulation from 
4. Click once on the red Stop Simulation button. 
5. At the end of the next set of slices the simulation will end. 
6. The workbook is redisplayed once the simulation is finished and the 

statistical outcome values are displayed in the Key Results pane. The 
simulator controls will now display the green New Simulation and 
Continue Simulation buttons again. 
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7.3 Reports 

 
 
The application features a range of graphical and text-based reports. 
All reports are produced by exporting data and information to templates that are 
built in Excel. This enables each user to customise or edit templates and reports 
to their own specification. 
 

7.3.1 Graphical  

 
 
Graphical reports such as S curves and frequency distributions may be easily 
produced (post simulation) for any cell in the workbook that is a Key Result  

 Press Key Output Hullogram (s-curve) to show the 10%, 50%, 90%, 
Statistical Mean and Deterministic values over the Total Price Distribution 
S-curve. 

 Press Key Output Convergence to show the range of outcomes of the 
Contract as an S-curve without overlays 

 Press Hi Definition S-curve for very detail graphical output, similar to Key 
output graph but with greater detail as it uses 1% steps. 
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 Press Hi Definition S-curve with risk occurrences for very detail 
graphical output, with data points for each simulation that also records 
the impact value of each risk at that point 

 

 
 Risk occurrence detail report 
 

 For sensitive reporting it may be necessary to use the risk occurrence 
report to check that risk occurrence matches the target probability if there is 
disparity extra simulations may be necessary to ensure a close match. 
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7.3.2 Drivers report 

 
The Driver analysis creates a new Excel workbook. The parameters can be can be 
finely tune through a series of dropdown and popup menus. 
To select what is include for the Category or Worksheet first tick the box on the 
report screen a popup menu will appear, highlight the items you  which wish to 
include by using ctrl key and left clicking required row then press Apply, your 
selection will be displayed next to category and worksheet. 
Once you have selected which uncertainties are to be used and what worksheets 
and categories are required press Sensitivity Driver Report progress popup 
screen will inform you of progress with a final message on completion. 
 

: It is suggested that you rename the Excel file generated to aid audit.  
 

 This is useful when you want to include the results of the sensitivity 
analysis for perusal by others, as a record of validation or as a guide to 
uncertainty assessment 
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7.3.3 Uncertainty report 

 
The Uncertainty driver analysis creates a new Excel workbook. The parameters 
can be can be finely tune through a series of dropdown and popup menus. 
To select what is include for the Category or Worksheet first tick the box on the 
report screen a popup menu will appear, highlight the items you  which wish to 
include by using ctrl key and left clicking required row then press Apply, your 
selection will be displayed next to category and worksheet 
 
Once you have selected which uncertainties are to be used which worksheets and 
category are required press Uncertainty Driver Report progress popup screen 
will inform you of progress with a final message on completion  
 

It is suggested that you rename the Excel file generated to aid audit.  
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7.3.4 Risk Report  

 
 
The Risk report creates a new Excel workbook. The parameters can be can be 
finely tune through a series of dropdown and popup menus. 
To select what is include for the Category first tick the box on the report screen 
a popup menu will appear, highlight the items you  which wish to include by 
using ctrl key and left clicking required row then press Apply, your selection will 
be displayed next to category. 
 
Once you have selected which risks are to be used and what categories are 
required press Risk Data Report progress popup screen will inform you of 
progress with a final message on completion  

It is suggested that you rename the Excel file generated to aid audit.  
 

7.3.5 Key results 

 
 
Press key results report to produce an Excel workbook that contains all the pre-
selected key results 
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7.3.6 General reports 

 

There are 4 options in the general section: 

Full Report 

 This feature can be used to package and export the primary assessment 
data and output results to an Excel workbook. 
The workbook contains:  

o The description of the workbook and its primary attributes  
o The complete range of outcomes of the analysis as described by an 

S-curve in 5% confidence level increments 
o The complete graphical outputs 
o The complete collection of: 

 sensitivities,  
 uncertainty,  
 risks, opportunities  

 associated Input Parameters and resulting Impact data 
 associated categorisation and classification 

information 
o Risk ownership information 

LPHI  
 This will produce an Excel workbook that lists all the elements that you 
have selected as low probability High Impact risks. 
 
Browse Existing Reports 
 Will open an existing Excel report 
 
Browse Existing Graphs 
 Will open an existing Excel workbook with graphical outputs 

 The browse function have been included to save you leaving the Arrisca 
program to establish what report names have been used. 
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7.3.7 Analysis & Reports contextual menu (right-click menu) 

 
 

 Select New (key result) 

 
 
This enable a new key result to added to list: 

 Press Select New then select the cell selection method. 

 The Excel workbook will be displayed enabling you to choose the new 
key result cell. 

 
 Press OK to close. 

 Remove selected from key Results 

 Select the row you wish to remove. 

 Right click and Select Remove selected from key results 

 Show S curve for selected 

 Select the Key results you wish to create a Hullogram. 

 Right click and select show Hullogram 
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  Show Hi Definition S curve selected  

 Select the Key results you wish to create a Hullogram. 

 Right click and select show Hullogram 
 

 Create DDC (Custom Distribution)  

This function allows you to save an output distribution from analysed key result 
this can then be used as an input distribution for any other task. 

 Select Key result row. 

 Right click and select create DDC. 

 Name file and press OK. 
 

 Goto to this cell in worksheet 

This function will take you straight to worksheet cell that is linked to the 
selected key result. 

 Select key result row 

 Right click and select Goto to this cell in worksheet 

 Scatter plot Key selected results 

This function utilises the Arrisca Project function so would not 
normally be used for an Excel model. However, there may a requirement to 
compare key items in this form, therefore the function is active but will 
require manual amendment to Excel plot as the default uses time in days as 
the base comparator not cost. 
 

This function allows two key results to be plot on single graph thus providing a view 
of what values where in play during the simulation. 

 

 Select the two row to be compared use Left click and Ctrl key. 

 Select Scatter plot for two key results 

 Amend Excel plot cell C 44 to Cost and change C47 to number 
format, change legend to Cost not duration. 
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  
 

8  Input Distributions and Levels 

 

8.1 Quantitative Input Distributions 

The application allows the selection and application of certain common input 
distribution shapes. These are selected using the drop-down boxes adjacent to 
the input parameter Descriptions for: 
 

 Uncertainty,  and for  

 Risk Driver Impact  
 
Although the same terminology is used, descriptions of Input Data Parameters 
vary dependent on whether the shape is being applied as Uncertainty or Risk 
Impact: 
 

Parameter 
Description 

Uncertainty Risk Driver Impact 

Minimum 
Value 

This is an optimistic estimate 
of what might happen, 
assuming that the risks do not 
materialise and that 
everything goes about as well 
as possible. 

This is an optimistic estimate 
of the minimum additional 
value that the occurrence of a 
risk impact will have over and 
above the baseline estimate. 

Most Likely 
Value 

This is the estimator's best 
bet, the sort of estimate that 
is right more often than any 
other (i.e. the mode, in 
statistical language). 

This is the best estimate of 
the additional value that the 
occurrence of a risk impact 
will have over and above the 
baseline estimate. 

Maximum 
Value 

This is a pessimistic extreme, 
assuming that the worst tends 
to happen, but excluding the 
very remote - e.g. "Acts of 
God". 

This is a pessimistic estimate 
of the maximum additional 
value that the occurrence of a 
risk impact will have over and 
above the baseline estimate. 

 
The common shape descriptions available to the user are detailed as follows: 
(Please refer to Glossary (section 9) for full explanations of terms. 



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 102 

8.1.1 Constant 

The Constant shape results in zero variation in the outcome. 
When applied to Uncertainty it effectively fixes the cell value at the value that is 
input in the Likely field, though this may differ from the Deterministic cell value. 
When applied to risk the impact will be fixed at the Likely field value. 
 
Application:  

 Where an alternative single-point estimate is to be used in simulation. 
 
Parameters: 

 Most Likely Value 
 
Graphical representation: 
 

 
 

Most Likely 
Likely Value 
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8.1.2 Uniform 

The Uniform shape describes a range of outcomes that has an equal chance of 
being any of value between two points, the Minimum and Maximum Values. 
 
Applications:  

 Very rough modelling where data is absent 

 When not much is known about the distribution of an outcome, (say, only 
its smallest and largest values) 

 
Parameters: 

 Minimum Value 

 Maximum Value 
 

 
 

Min Max 
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8.1.3 Triangular 

The Triangular shape describes a defined range of outcomes between two points 
plus a Most Likely value that lies between the Minimum and Maximum Values. 
 
Application:  

 3PE for rough modelling where data is absent 

 The Triangular Distribution is typically used as a subjective description of 
a range for which there is only limited sample data, and especially in 
cases where the relationship between variables is known but data is 
scarce. It is based on knowledge of the minimum and maximum and an 
"inspired guess" as to the modal value. 

 
Parameters: 

 Minimum Value 

 Most Likely Value 

 Maximum Value  
 
Graphical representation: 
 
 

 
 

 Trianglewhole 

 
Special variant of a normal triangle that will only generate whole numbers use 
when decimal values will cause issues such as design to cost models where it 
impossible to have a part component eg. ½ a reinforcing rib in a hull   

Min Most Likely 
Likely Value 

Max 
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8.1.4 Beta (PERT) 

The Beta is a Triangular shape describing a defined range of outcomes between 
two points plus a Most Likely value that lies between the Minimum and Maximum 
Values, but where the outcomes strongly tend toward the Most Likely value. 
 
Application:  

 3PE for rough modelling where data is absent but there is some assurance 
that the Most Likely value is a confident outturn compared to the extents. 

 Used for estimates to completion where the Most Likely value is sound. 
 
Parameters: 

 Minimum Value 

 Most Likely Value 

 Maximum Value  
 
Graphical representation: 
 

 
 

 BetaWhole 

Special variant of a normal Beta that will only generate whole numbers use when 
decimal values will cause issues such as design to cost models where it 
impossible to have a part component eg. ½ a reinforcing rib in a hull    

Min Most Likely Max 
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 Normal 

It is often called the bell curve because the graph of its probability density 
resembles a bell. 
 
Applications:  

 Financial uncertainty 

 Populations of physical data 

 Biological distributions 
 
Parameters: 

 μ (Mean Value) 

 σ (Sigma, Standard Deviation  Value) 
Graphical representation: 
 
 

 
 

Mean 

Sigma 
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8.1.5 Lognormal 

The log-normal distribution is the single-tailed probability distribution of any 
random variable whose logarithm is normally distributed. It cannot generate a 
negative polarity outcome as the results are always positive 
 
Applications:  

 Sizing of requirements or resources 

 Populations of geophysical data (such as oil-well reserves) 

 Biological distributions 
 
Parameters: 

 μ (Mean Value) 

 σ (Sigma Standard Deviation Value) 

 Determinate  
 

Graphical representation: 
 

 
 
 
.! 

Mean 

Sigma 
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8.1.6 Custom Discrete –  

Like a die roll, the outcome values are limited to a finite range of definite 
outcomes with an assigned probability value for each outcome. All outcome 
probabilities must sum to 1 (unity). 
 
Applications:  

 Die-like assessments (1,2,3,4,5 or 6 – each with 16.667% probability. 

 Where there is a modal outcome (levies or damages applied). 
 
Parameters: 

 Outcome (unlimited) 

 Probability of outcome. 
 
Graphical representation: 
 
 

 
 

OC1 OC2 OC3 OC4 OC5 
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8.1.7 Custom Continuous–  

 
Applications:  

 Where up to 101 points describe an input curve - used where there is 
historical data or where there are specific cost or engineering outcome 
definitions available for transcription 

 
Parameters: 

 0% to 100% cumulative values in 5% increments (21 point estimate) 
 
Graphical representation: 
 
 

 
 
 

Min Max 
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8.1.8 Data Cartridge -  

 
Applications:  

 Where the output of a separate simulation and analysis is to be used as an 
input distribution range for an input cell. 

 
Parameters: 

 0% to 100% cumulative values in 5% increments (21 point estimate) 
 
Graphical representation: 
 
 

 
 

   

Min Max 
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9 Application Metadata and Settings 

 

9.1 Main Menu  

9.1.1 File 

 
 

9.1.2 Open New spreadsheet 

This option will take you to the specified folder and allow you to open a new 
spreadsheet. 

9.1.3 Reopen Current Spreadsheet 

If the workbook that is being analysed gets closed for some reason either 
intentionally (because the user wants to discard all changes) or by accident this 
command will automatically reopen the current spreadsheet for you. 

9.1.4 Refresh Current Spreadsheet 

This command is used to update the Arrisca software with any changes that may 
have been made to the structure, formulas or constants in the spreadsheet. If 
the spreadsheet has been modified by the user whilst it has been open with 
Arrisca the spreadsheet must be first saved and then this command to update 
Arrisca with the changes. 

9.1.5 Save RAF file 

This allows you to save both Arrisca inputs/outputs and the Excel sheet in one 
file. 
This file is a compressed archive and contains the following elements: 

 A copy of the spreadsheet that is being analysed (that can be redeployed 
when the archive is reopened on another machine at a later date), 

 All user inputs / outputs and associated comments 

 Associated risk and uncertainty registers 

 All analytical results and reports which can be immediately accessed. 

  : This provides an excellent method for creating an archive document 
that as well containing the results of the analysis also contains a frozen copy 
of the Excel workbook that the analysis was based on.  
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9.1.6 Open RAF file 

Will open a RAF file so that the Arrisca tool is populated and the associated Excel 
file is opened. 

9.1.7 Exit Application 

 
 
When Exit or Close application is selected the close down menu is displayed, this 
gives you the option to: 

 Save – save file without renaming 

 Save As- save as a new file 

 Don’t save – any changes are lost 

 Cancel – skip shut down 

9.1.8 Edit 

 
 

 Qualitative Settings 

The Qualitative assessments that are possible in Arrisca Velocity use Qualitative 
Assessment Level Definitions to provide parameter sets for analysis.  
The Levels are accessed from the Main Menu select Edit > Qualitative Settings  
This displays the Edit Levels Function Tab as shown below: 
 
The default level definitions are as follows: 
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 Probability Levels 

 

 
 
 
 

 Relative Risk/Opp Impact Levels 
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 Absolute Risk/Opportunity Impact Levels 

 

 
 

Absolute option will add the deterministic value to the pre-determined 3 
PE defined by in this table. This option is best suited to “Design to cost” modelling 
when detailed risk impact information is limited.  
 

 Relative Uncertainty Levels 

 

   

 Level management and configuration 

All the Edit levels can be changed or added too via the right hand data panel: 

 Changes, select the row you wish amend and update the associated 
metadata use Save to store data  

 New, select New input description, then use Assessment to define the 
impact or probability; Order by refers the order the content will be 
displayed in the dropdown menu 
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 Type Settings (Risk and Drivers) 

 
 

 Status- Risk term to describe the life cycle of the risk and will be defined 
in risk management process  

 Severity-Impact of the risk; these are defined by your Organisation’s risk 
management process 

 Category (for Risk)- The part of business that effected by the risk; this 
defined by risk management process. 

 Risk Level- The ranking of risks by their effect; the number of risk levels 
will be defined in risk management process. 

 Classification- What type of risk is it can it be grouped with other risks 
e.g. By Cost impact, by Time, etc, these will be defined in risk 
management plan. 

 Phase Type- describes when the risk is likely to occur. For an ISO 15 288 
company this the CADMID phases.   

 Driver Category-  What part of the Business or process is affected e.g. 
Wage rates, Material, Testing, etc 

 Type Settings management and configuration 

 
 
 

 All Type settings can be changed or added too via the right hand data 
panel: 

 Changes, select the row you wish amend and update the associated 
metadata use Save to store data 

 New, select New input description and associated data and press Save. 
Order by refers the order the content will be displayed in the dropdown 
menu 
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 User Information 

 
 
This provides a method of controlling data and providing an audit trail. It will 
require the risk management plan to define Users limitations.  
 

 Users can be changed or added too via the right hand data panel: 

 Changes: select the row you wish amend and update the associated 
metadata use Save to store data 

 New, select New input details and press Save. Order by refers the order 
the content will be displayed in the dropdown menu 

 

 User-Custom Distributions 

 
 
This feature allows you to add a custom distribution; this may be data from a 
previous project that best describes a possible outcome if a risk occurs. 
 
Create distribution 

 Select New from data input panel, fill in the blank metadata cells Name, 
Order (default =1) and Active are mandated inputs others are optional. 

Distribution data input 
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 The shape of the distribution is described by an outcome value and the 
point at it occurs (Cumulative_Prob). The Outcomes must be a 
progressive value and the Cumulative probability must also be progressive 
with a range of 0 to 1. A maximum of 21 data points are allowed; press 
Save.  

 Once entered the distribution can viewed in Excel by selecting the Show 
Shape in Excel button (see above). 

 Plots can be amended in Excel 

 Change cumulative prob or outcomes. 

 Press Validate button in workbook to check that data conforms. 

 Return to Arrisca and select Retrieve shape from Excel button 
 

 Press Save to store shape. 
 

9.1.9 Tools 

 

 Purge all inputs and results data 

After several runs of the software certain internal computer memory devices will 
need to be reset to eliminate inconsistent results, select this option to clear 
memory. 
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  Global Import 

 

 From External Register (.xls) 

 Enables a saved formatted risk register to be imported and used as a 
template for a new workbook.  

 Import Levels 

 Import risk levels from .xlm file 
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 Import Custom Shape 

 Import custom shape  from Excel workbook  

 Configuration Settings 

 To maintain constancy of approach you can import a saved configuration 
from an earlier task via a .xlm file.  

 Load Default Types 

 Reset to “Factory supplied” values 
 

 Load Default Qualitative Levels 

 Reset “Factory Supplied” values 

 Import DDC (custom distribution) 

The Arrisca software allows you create DDC file which captures a distribution 
from a previous analysis and may represent a input distribution for a new analysis 

 From the Tools tab on the main menu select Import DDC (Custom 
Distribution)  

 Select the required file from the Import Custom Distribution popup. 

 A popup will confirm the file has been imported, Press OK.   
 

 
 

9.1.10 Global Export 
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 Export to External register (.xls) 

 

 Export Levels to Excel  

 Saving the custom Levels will you to reuse Levels for similar tasks. 

 Export Custom shape to Excel  (.xls) 

 Saving Custom Shapes allows reuse for other tasks 

 Export Configuration Settings  

 Saving Configuration settings allows reuse for other tasks 
  



Arrisca Velocity – Flex Professional™ User Guide 
 

Software Version 4.0 –Feb  2015 Page 121 

 

9.1.11 Manage Display Options 

 

 Percentiles Columns  

 
 The Analysis results display can be changed to suit your requirements 

 Select the required percentage values and press Apply then Close. 

 By selecting  Default you can reset to “Factory settings”  
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 Decimal Places 

 
 The decimal places shown in the result displayed can be adjusted to level 

you require, this is useful when working in £k. 

 Input required value and press Apply then Close. 
 

 Messages 

 
 

 Messages are useful to track progress or warn you of error, but they do 
slightly increase process time, these options allow you to change the 
frequency or turn then off completely.  

 Input record refresh rate  

 Un-tick box to switch off information messages then press Apply and 
Close. 
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 Impact Colour 

 
 

 This options allows you to change the ‘Impact colour’ used . 

 Select required colour setting and press Apply then Close 

 The invert button will swop the ”increase” and “decrease” selections 
press Apply then Close 

 Default resets to “factory Settings” 

9.1.12 Automation 

 

 The Arrisca software can be run automatically by dragging the Excel 
workbook over the Arrisca Desktop icon. However, for this to function to 
work the workbook must be constructed in particular format. 

 Load spreadsheet Template  

 Run Template 

 Add Template to this Workbook- 
 
See template layout below. 
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  If you have many ranges of “Risks” or “Uncertainties” it is good 
practice to use named ranges that have a common name start as this will 
allow global import via the Name$ function e.g Riskrange1, Riskrange2, et 
seq these can be imported by using Riskrange$ in Cell D28 only   

9.1.13 Load Default Application Settings 

 

 Select this option to reset all levels, Category’s and Classification’s to 
“Factory setting”. 
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9.1.14 Distribution Explorers 

 
 The explorer tool allows you picture the distributions based on a Normal 

and Log Normal basis. 

 Select which option Normal or Log Normal an Excel workbook will open, 
there are only 2 inputs required Desired mean and number of Standard 
Deviations  

: The use of a log normal can have a significant effect in that it 
concentrates impacts at the lower end of the probability scale but 
extreme high impacts compared to a normal distribution. It should only 
be used when there evidence to justify its use. 

9.1.15 Refresh Screen 

 This is a standard refresh function use when display’s get over written 
with spurious data. 

9.1.16 View & Browse Data Area 

 This function will start the Windows Explorer and take you straight to the 
folder where you have stored files. 
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9.1.17 Reset Data Area 

 This will reset all data area and restart software.  
 

 

: Use with caution as Arrisca will shut down and your data may 
be lost. 

9.1.18 Simulate Crash 

 The simulate crash function is to provide you with confidence in the 
Arrisca’s capability to capture your inputs as you progress through the risk 
analyse assessment (sensitivity, uncertainty, etc). 

: Use this to demonstrate the Arrisca’s tool robustness. 

9.2 Help 

 

9.2.1 About riskHive Analyser 

 Will display the issue, build state release date and contact information 

9.2.2 EULA 

 Will display a copy of the software licence agreement. 

9.2.3 Documentation and Guides 

 Will link you the riskHive Web site where you can access online help files 

9.2.4 Event Log 

 Will display in MS Note a recorded of all the error logs created for the day. 
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9.2.5 Licensing and upgrades 

 Will link you the riskHive Web site where you can obtain information 
regarding licensing and upgrade keys 

9.2.6 Enter upgrade key 

 Input new upgrade key code 
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10 Quick start guide  

Yes No 

If you have basic 
uncertainty information 

If you have basic risk 
register information 

Construct 
Pricing 

Model (XL) 

Attach XL 
File to 

Arrisca 

Include Variability (3-Point 
Estimates – shape optional) 

min deterministic max shape 

 

Include Risks (Names, 
Probabilities, Impacts) 

Name Prob min exp max 

 

Run Driver 
Analysis 

in Arrisca 

Use Import controls to 
grab risk and/or 3PE 
information from XL 

pricing model. 

This will help you to validate the 
operation of the Excel worksheet 
and show you the most significant 
cells that affect the final outcome. 

Include 
risk and 
3PEs? 

 

Input to define risk and/or 

3PE information. 

Select 
‘Key 

Results’ 

Key Results are cells for 
which you may want to see 
statistical data from the 
MCS simulation. By default 
only the final outcome is 

selected. 

Run 
Analysis 

(MCS) 

Produce 
graphs & 

reports 

You can generate standard graphs 
and reports using the application. A 
pre-populated report template can 
be sent to Word. 

Deploy 
data to XL 

model 

You can repopulate the original 
pricing model with the results of 
analysis. This enables a ‘risked’ 
model to be constructed and saved. 

Monte Carlo simulation (MCS) 

Results not what 
you were 
expecting? 
 
Need more help?  
 
Trying something 
new?   
 
Call Technical 
Support  
0117 373 1100 
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11 Glossary 

 
 

Term Definition 

3PE abr. See Three-point Estimate 

Assess Risk 

The activity within the Risk Management Process 
of prioritising identified Risks against agreed 
criteria. It includes the systematic:  

 determination of the likelihood of an event 

(Probability) 

 assessment of severity of consequences 

(Impact) 
assignment of responsibility 
(Risk Owner) 

Analyse Risk  

The activity within the Risk Management Process 
of using a simulation or modelling technique to 
produce the whole range of possible outcomes 
from the data collected during the Assess Risk 
process. See Monte Carlo simulation. 

Attached workbook The Excel workbook to which the Arrisca 
application is attached and is able to process. 

Bell Curve See Frequency Distribution 

Cell-selector tool 
The Excel pop-up window that allows the 
selection of a cell or range of cells for further 
processing 

Central limit theorem 

The central limit theorem (CLT) states that the 
sum of a large number of independent and 
identically-distributed random variables will be 
approximately normally distributed (i.e., 
following a Gaussian distribution, or bell-shaped 
curve) if the random variables have a finite 
variance. 

Central limit theorem avoidance 

Don’t use more than about 30 elements of 
uncertainty with common distribution shapes in 
any one simulation parameter set, or use 
probabilistic risk with a likelihood of 100% to 
separate values. 

Confidence Figure (%)  

A Confidence Figure is the likelihood of meeting 
or bettering a specific parameter (time, cost or 
other). The confidence figure is normally defined 
as a percentile (%) figure and is derived from 
quantitative modelling (statistical analysis) using 
such tools as Monte Carlo Simulation.  

http://en.wikipedia.org/wiki/Independent_and_identically-distributed_random_variables
http://en.wikipedia.org/wiki/Independent_and_identically-distributed_random_variables
http://en.wikipedia.org/wiki/Normal_distribution
http://en.wikipedia.org/wiki/I.e.
http://en.wikipedia.org/wiki/Mathematical_jargon#finite
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The MOD Approvals process places importance on 
the likely outcome (time and cost) at the 10%, 
50% and 90% Confidence Figures which must not 
be confused with Three Point estimating.  

Confidence Interval 
The population of statistical outcomes existing 
between the 10% and 90% Confidence Figures in 
which 80% of all the outcomes lie. 

Consequence  
The effect the occurrence of a Risk has on the 
planned progress or outcome of a project or 
programme plan.  

Context  
The detail regarding the events, circumstances, 
and interrelationships that may lead to a Risk 
Event occurring.  

Cumulative Frequency 

Distribution 
The integration of the Frequency Distribution. 
Graphically known as the S-curve due to its shape 

Data Cartridge 

A self-contained package of Arrisca analysis data 
and parameters that can be used to transfer 
information between models and applications 
using XML. 

Distributions: 

Input: 

Types 

 

Driver Analysis 

An analytical technique that facilitates the 
identification and quantification of input 
sensitivities with respect to an identified outturn 
calculation 

Enterprise Analytics 

The technique of consolidating and analysis data 
from around the Enterprise in an analytically and 
statistically correct manner to aid decision 
support 

Event  

In Risk Management an Event is the occurrence of 
unplanned/uncertain circumstances which lead to 
a detrimental impact (positive for opportunities) 
on planned project progress or outcomes.  

Excel Microsoft’s proprietary spreadsheet application 

Fallback Plan  

A Risk Handling Option that defines alternatives 
only to be taken up if a Risk occurs or a 
mitigation plan has failed to have the intended 
effect or a risk decision point is reached.  
(See also Mitigation Plan)  

Feature Bar 
The upper area of the Function Tab which 
contains the context-specific controls for each 
screen 
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Frequency Distribution 

Relative frequencies of value intervals can be 
shown in a frequency distribution – also known as 
a Bell Curve. The frequency of each value is 
indicated by points or dots drawn at the 
midpoints of each value interval. A smooth curve 
is used to connect the points and, similar to a 
graph, is plotted on two axes: The horizontal axis 
from left to right (or x axis) indicates the 
different possible values of some variable (the 
outcome of the simulation). The vertical axis 
from bottom to top (or y axis) measures 
frequency or how many times a particular value 
occurs. 

Frequency Polygon 

 

Relative frequencies of value intervals can be 
shown in a frequency polygon. The frequency of 
each value is indicated by points or dots drawn at 
the midpoints of each value interval. Those points 
are then connected by straight lines.  

Function Tab 
Function Tabs allow easy switching between the 
primary function areas application and contain 
the Feature Bars, Controls and List Panels. 

Hullogram 

The Hullogram is a primary graphical output of 
the Arrisca application. It is a dataset that is 
exported to an Excel template which 
automatically produces graphs and reports based 
on the following data: 

 Deterministic (single-point target value) 

 Bell-curve 

 S-curve 

 10% Confidence figure 

 50% Confidence figure 

 90% Confidence figure 

 Statistical mean outcome value 

Identify Risk  

The activity within the Risk Management process 
to find, list and characterise elements of Risk.  
NOTE: Elements include Context, Risk Source, 
Event and Consequence. Opportunities may also 
be revealed.  

Input Distribution 
The means of describe the range of input values 
that will be used in simulation. Usually a shape 
plus a parameter set. See Distributions 

Issue  

A significant certain occurrence differentiated 
from a Risk by virtue of its certainty of 
occurrence and by the fact that it should be 
accounted for in Planning & Scheduling activities 
and not Risk Management.  

Key Outcome Cell The cell in the Excel workbook whose outturn is 
the focus of the analysis. 
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Key Result 

The name given to a cell which is selected to 
have statistical results calculation during 
simulation. Accessible from the Key Results 
Function Tab. 

Manage Risk  

The activity within the Risk Management Process 
of implementing, monitoring, reporting and 
reviewing Risk Management actions against 
objectives.  

Maximum Value 
This is a pessimistic extreme, assuming that the 
worst tends to happen, but excluding the very 
remote - e.g. "Acts of God". 

Metamodelling 

The term used to describe the technique of 
applying overlays to an existing model to ‘shock’ 
or ‘flex’ it into generating a different range of 
outturns. 

Minimum Value 
 

This is an optimistic estimate of what might 
happen, assuming that the risks do not 
materialise and that everything goes about as 
well as possible. 

Mitigation Plan  

A Risk Handling Option that sets in place actions 
to reduce the Probability and/or the Impact of a 
Risk prior to its occurrence. 
(See also Fallback Plan)  

Monte Carlo Simulation 

Monte Carlo methods are a class of computational 
algorithms that rely on repeated random sampling 
to compute their results. Monte Carlo methods 
are widely used when simulating physical and 
mathematical systems. Because of their reliance 
on repeated computation and random or pseudo-
random numbers, Monte Carlo methods are most 
suited to calculation by a computer but can be 
replicated manually. Monte Carlo methods tend 
to be used when it is infeasible or impossible to 
compute an exact result with a deterministic 
algorithm (as in the case of Confidence Figures)  
There is no single Monte Carlo method; instead, 
the term describes a large and widely-used class 
of approaches. However, these approaches tend 
to follow a particular pattern: 

 Define a domain of possible inputs. 

 Generate inputs randomly from the 
domain, 

 Perform a deterministic computation on 
them.  

 Aggregate the results of the individual 
computations into the final results. 

The term Monte Carlo method was coined in the 
1940s by physicists working on nuclear weapon 
projects in the Los Alamos National Laboratory.[ 

http://en.wikipedia.org/wiki/Computation
http://en.wikipedia.org/wiki/Algorithm
http://en.wikipedia.org/wiki/Random
http://en.wikipedia.org/wiki/Computer_simulation
http://en.wikipedia.org/wiki/Physics
http://en.wikipedia.org/wiki/Mathematics
http://en.wikipedia.org/wiki/Random_number
http://en.wikipedia.org/wiki/Pseudorandomness
http://en.wikipedia.org/wiki/Pseudorandomness
http://en.wikipedia.org/wiki/Computer
http://en.wikipedia.org/wiki/Deterministic_algorithm
http://en.wikipedia.org/wiki/Deterministic_algorithm
http://en.wikipedia.org/wiki/Los_Alamos_National_Laboratory
http://en.wikipedia.org/wiki/Monte_carlo_simulation#cite_note-1#cite_note-1
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Most Likely Value 
 

This is the estimator's best bet, the sort of 
estimate that is right more often than any other 
(i.e. the mode, in statistical language). 

Opportunity  

A Risk with positive Consequences. Combination 
of the Probability of an Event occurring and its 
positive Consequences on objectives.  
(See also Risk)  

Optimism Bias  

The demonstrated systematic tendency for 
appraisers to be over-optimistic about key project 
parameters. The MOD process for addressing 
Optimism Bias is detailed in JSP507.  

Plan  
The activity within the Risk Management Process 
of selection and implementation of Risk Handling 
Options.  

Probability  

The likelihood that an event (Risk) will occur 
usually described as a percentile figure. A 
probability approaching 100% should be 
considered as certain event and included in 
project plans and budgets.  

Residual Risk  
Risk remaining after Risk Handling Options have 
been implemented.  

Risk  

A significant uncertain occurrence, differentiated 
from an Issue by virtue of its lack of certainty. A 
Risk is defined by the combination of the 
Probability of an Event occurring and its 
Consequences on objectives.  
NOTE: The term “Risk” is generally used to 
embrace the possibility of both negative and/or 
positive consequences. However, “Opportunity” is 
specifically used to define those Risks with only 
the possibility of positive consequences. 
Additional Information: All Risks should be 
described in a consistent and unambiguous 
manner. Projects are recommended to adopt a 
structured method to capture data on identified 
risks. For an example of good practice in this area 
download Risk Description Discipline document.  

Risk Factor  
The factor(s) that govern(s) the probability 
and/or impact attached to a Risk.  

Risk Handling Options  

Mitigation action for reducing the Probability 
and/or Impact of a Risk this includes Treat, 
Transfer, Tolerate and Terminate, also the 
provision of Fallback Plans. 
(For Opportunities handling options are designed 
to enhance and encourage the likelihood of 
occurrence and increase the Impact on 
outcomes.)  

http://www.aof.mod.uk/aofcontent/tactical/risk/content/optimism.htm
http://www.aof.mod.uk/aofcontent/tactical/risk/downloads/asmbaes.pdf
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Risk Impact  
A measure of the severity of a Risk consequence. 
(Can be positive for Opportunities )  

Risk Management  

The systematic application of management 
policies, procedures and practices to the tasks of 
establishing the context, identifying, analysing, 
planning and managing Risks in a way that will 
enable organisations to minimise loss and 
maximise opportunity in a cost-effective way.  
NOTE: The Risk Management Process includes the 
activities of Identify, Analyse, and Plan & 
Manage.  

Risk Management Plan  

A description of how Risk is to be managed within 
a project. It defines Risk Management Roles, 
Responsibilities, Methodology, Tools and 
Techniques specific to a project.  

Risk Management Strategy  

A description of the objectives of Risk 
Management in relation to the overall objectives 
and context of a project. It includes 
interrelationships between Risk Management and 
other project activities and must demonstrate 
that Risk Management fits within a project’s 
Through Life Management approach.  

Risk Manager (or Risk Process 
Manager)  

The person within a Project with the overall 
responsibility, accountability and authority for 
ensuring that the Risk Management Process is 
deployed and operated effectively.  

Risk Owner  

The individual with the overall responsibility, 
accountability and authority for the planning & 
management of a Risk. 
NOTE: The Owner of a Risk should be that 
individual best able to manage the source of the 
Risk.  

Risk Source  
The underlying set of circumstances and factors 
that lead to the existence of a Risk.  

S-curve See Cumulative Frequency distribution 

Secondary Risk  
A Risk arising solely from the adoption of a Risk 
Handling Option.  

Simulation See Monte Carlo Simulation 

Slice A single iteration of Monte Carlo sampling 

Source  
The root cause of a risk occurring described in 
terms of the risk Event and circumstances leading 
to it not the consequences of the event occurring.  

Terminate 
(Avoid)  

Some risks will only be treatable, or containable 
to acceptable levels, by terminating or avoiding 
the activity or activities that give rise to the risk.  
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Three Point Estimate  

A technique that uses three values to characterise 
an estimate; Minimum through Most Likely to 
Maximum that are the basic input values for 
quantitative analysis. The three values needed 
are defined as follows:  

 Minimum – This is an optimistic estimate of 

what might happen, assuming that the risks do 

not materialise and that everything goes about 

as well as possible.  

 Most Likely - This is the estimator's best bet, 

the sort of estimate that is right more often 

than any other (i.e. the mode, in statistical 

language).  

 Maximum - This is a pessimistic extreme, 

assuming that the worst tends to happen, but 

excluding the very remote - e.g. "Acts of God".  

Tolerate 
(Accept)  

The ability to do anything about some risks may 
be limited, or the cost of taking any action may 
be disproportionate to the potential benefit 
gained. In these cases the response may be 
toleration.  

Transfer  

For some risks the best response may be to 
transfer them. Namely, shift the responsibility or 
burden of loss to another party through 
legislation, contract, insurance or other means. 
This may also occur through Public Private 
Partnership (PPP) or Customer Supplier 
Agreement (CSA) re-negotiation activity. Partial 
transfers are known as risk sharing or risk 
assignment.  

Treat 
(Reduce)  

By far the greater number of risks will belong to 
this category. The purpose of treatment is not 
necessarily to obviate the risk, but more likely to 
contain the risk to an acceptable level. The 
actions taken to handle risk are instigated by the 
Risk Owner although their effects may be felt 
outside of the Risk Owner's organisation.  

Uncertainty  

A condition where the outcome can only be 
estimated.  
NOTE: the term Uncertainties is also specifically 
used to describe uncertain occurrences that are 
considered insignificant in terms of impact on 
objectives.  

Workbook The generic name of the file created and 
operated by Microsoft’s proprietary Excel 
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application. Workbooks use the .xls file 
extension. 

Worksheet The generic name of a tab contained within an 
Excel workbook. 
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12 Support 

 
 
Your appointed reseller is: 
 
riskHive Ltd. 
Dilkush 
2 Farlers End 
Nailsea 
Bristol BS48 4PG 
 
Tel:  +44 (0)117 373 1100 
Fax: +44 (0)117 373 1103 
www.riskHive.com 
 

Support 
 
Support service: Via the ‘feedback & support’ online service. It will keep you 
posted on the progress of your enquiry  
 

 
 
Alternatively 
 
email: support@riskhive.com 
 
Phone +44(0)117 373 1100 
 
Support lines are open from 09:00 to 17:30 (GMT) Monday to Friday. 
 
General enquiries email: info@riskhive.com 
 
 
 

http://www.riskhive.com/
mailto:support@riskhive.com
mailto:info@riskhive.com

